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Wprowadzenie

O systemie Arc

System Arc firmy HAMILTON jest nowoczesnym, zintegrowanym srodowiskiem, zapewniajacym
skuteczna i bezpieczna , bezprzewodowa i przewodowa komunikacje, umozliwiajaca zarzadzanie
r6éznego rodzaju czujnikami i monitorowanie ich pracy.

Uzyskuje si¢ dzigki niemu polaczenie oszczedno$ci kosztow oraz niezawodnoS$ci czujnikow
z duzymi mozliwo$ciami, wygoda i tatwoscia przenoszenia jednostki r¢cznego monitora
systemu Arc View Handheld, a takze korzysciami dla uzytkownika wynikajacymi
z automatycznego kalibrowania do wzorcéw w laboratorium, kalibrowania dla wyrobu
w srodowisku technologicznym, czy tez mozliwoscia natychmiastowego sprawdzania wskazan do
30 czujnikéw w dowolnej chwili.

O tej Instrukcji obstugi

Niniejsza Instrukcja jest przeznaczona dla wszystkich obstugujacych system analiz techno-
logicznych Arc firmy HAMILTON. Instrukcja petni dwie podstawowe funkcje:

o Daje przeglad zintegrowania calego systemu Arc: czujnikow, przewodow i adapterow
czujnikow bezprzewodowych Arc Wi.

o Szczegdlowo wyjasnia sposob uzytkowania recznego monitora systemu Arc View Handheld.

Jak korzysta¢ z tej Instrukcji

Po pierwsze, nalezy dobrze pozna¢ podstawowe funkcje r¢cznego monitora systemu Arc
irozroznia¢ funkcje Uzytkownika, Administratora i Specjalisty. Tego mozna si¢ dowiedzie¢
z rozdziatu 1 tej Instrukcji ,,1. Przeglad i podstawy teoretyczne”.

Nastepnie, mozna sprobowac wykona¢ niektore zadania, ktorych wymaga pelniona przez
uzytkownika funkcja. Pomoca bedzie tu rozdziat: ,,2. Objasnienia zadan recznego monitora”.

Jezeli uzytkownik natrafi na trudno$ci w zrozumieniu funkcji jakiego$ ekranu lub pola, powi-
nien korzysta¢ z rozdziatu: ,,3. Wzory ekranow recznego monitora”. W razie problemu
ze znalezieniem zadanego pola, mozna zajrze¢ do indeksu na koncu Instrukc;ji.
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Uwagi dotyczace bezpieczenstwa

m]

Reczny monitor systemu Arc View Handheld jest chroniony przed czynnikami srodowiskowymi
zgodnie ze znormalizowanym stopniem ochrony IP 67. Nie dotyczy to jego stacji
dokowania (Dock). Z tego wzgledu, stacji Dock nalezy uzywac tylko w miejscach
chronionych przed wilgocia.

Nie wolno otwiera¢ zasilacza — tadowarki.

Nie wolno stosowac systemu Arc, ani elementow tego systemu, w sSrodowiskach zagrozenia
wybuchem (strefy zagrozen ATEX).

Do sterowania procesem technologicznym nalezy uzywaé¢ wylacznie przewodowych
potaczen analogowych lub cyfrowych. Bezprzewodowy interfejs Arc shuzy tylko do
monitorowania czujnikéw oraz dzialan konserwacyjnych i serwisowych.

Nie wolno otwiera¢ r¢cznego monitora systemu Arc. Tylko doswiadczeni technicy serwisowi
moga wymienia¢ jego wewngtrzny akumulator.

Nie wolno uzywaé¢ wewngtrznego czujnika temperatury ktoéregokolwiek czujnika Arc do
sprawdzania temperatur technologicznych

Ostrzezenia dotyczace sprzetu

m]

Nie stosowac rozpuszczalnikow, silnych kwasow, zasad lub amoniaku (NH,), w postaci
gazowej lub innej, do czyszczenia r¢cznego monitora systemu Arc View Handheld lub
jego stacji dokowania Dock.

Nalezy zachowac ostrozno$¢, aby nie zniszczy¢ ekranu rgcznego monitora Arc przy czyszezeniu.
Drobne czastki zanieczyszczen na §ciereczce moga powodowacé jego zarysowania. Zaleca
si¢ wige uzycie w tym celu zawsze nowej chusteczki higienicznej.

Przyjete w tej Instrukcji oznaczenia drukarskie

Przyklad Objasnienie
Graph Czcionka Courier wskazuje tekst na ekranie recznego monitora
systemu Arc.
View Czcionka Courier podkres$lona wskazuje przyciski ekranowe recznego
monitora Arc.
[Sensor] Czcionka Courier w nawiasach kwadratowych oznaczono zmienne

na ekranie rgcznego monitora Arc.

[Sensor] oznacza czujnik Arc, pokazywany na ekranie r¢cznego
monitora systemu Arc.
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1. Przeglad i podstawy teoretyczne

Ten rozdzial zawiera szczegoétowy opis recznego monitora systemu Arc View Handheld oraz
zasady i teorig lezacg u podstaw jego uzycia, wraz z pozostalymi elementami systemu Arec.

1.1 Przygotowanie do uruchomienia

Opakowanie rgcznego monitora systemu Arc zawiera nastgpujace elementy:

o Regczny monitor Arc View i stacj¢ dokowania Dock.

s pmm——

o Zasilacz recznego monitora i stacji dokowania. Wymaga on zrédta pradu 100 do 240V
i posiada adaptery do standardowych gniazdek elektrycznych w Europie, Wielkiej Brytanii,
Australii oraz USA.

o Kabel Arc VP 8. Jest to kabel przesytania danych i zasilania migdzy czujnikiem a stacja
dokowania (Dock).
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1.2 Nastawianie r¢cznego monitora Arc View Handheld

Re¢czny monitor systemu Arc, firmy HAMILTON, jest tatwy do nastawienia i wygodny
w uzytkowaniu, jako narzedzie konfiguracji i kalibrowania czujnikow Arc tej samej firmy.

Ponizsze kroki opisuja procedurg nastawiania, zarowno dla opcji potaczen przewodowych,
jak i bezprzewodowych:

1. Podlaczy¢ dostarczany kabel Arc VP8 do stacji dokowania Dock.

2. Podlaczy¢ jeden z czujnikdw Arc (nie wehodzi w zakres dostawy rgcznego monitora) do
wtyczki VP8 kabla czujnika.

3. Umiesci¢ rgczny monitor Arc View w stacji dokowania Dock.

4. Przylaczy¢ kabel zasilacza do stacji dokowania Dock i wetkna¢ zasilacz do gniazdka
elektrycznego o wlasciwym napigeiu (100 do 240V AC).

b

Wiaczy¢ reczny monitor Arc View, naciskajac rownoczesnie przyciski ,,lewy” i,,prawy”
przez 3 sekundy. Po uruchomieniu, r¢czny monitor automatycznie rozpoznaje i wyswietla
podlaczony czujnik.

Uwaga
W tym uktadzie reczny monitor dziata jako system stotowy w $rodowisku
laboratoryjnym, a nie przemystowym.

W przypadku podlaczenia bezprzewodowego:

1. Wetkna¢ adapter czujnika Arc Wi (nie wchodzi w zakres dostawy recznego monitora)
migdzy czujnik Arc i kabel tego czujnika.

2. Wyjad reczny monitor Arc View ze stacji dokowania Dock. Potaczenie bezprzewodowe
zostanie ustanowione automatycznie.

Uwaga
W tym ukladzie r¢czny monitor moze by¢ uzywany jako przeno$ne narze¢dzie do
zastosowan zarowno laboratoryjnych, jak i przemystowych.
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Kabel Arc VP8

Kabel zasilania elektrycznego

Rysunek 1.1: Wtyki stacji dokowania (Dock) recznego monitora Arc View

1.3 Przyciski i ekran re¢cznego monitora Arc View
Wlaczanie i wylaczanie

Aby wlaczy¢ reczny monitor, nalezy nacisnaé¢ rdéwnoczesnie przyciski ,lewy” i ,,prawy”
przez trzy sekundy. Aby przyrzad wyltaczy¢, trzeba na trzy sekundy nacisnac przycisk
,»W dot”. Wigcej informacji na ten temat podano w punkcie: ,,1.4 Zarzadzanie zasilaniem
recznego monitora Arc View”, na stronie 16.
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B. Poziom obslugujacego C. Numer czujnika p_ Stan potaczenia bezprzewodowego

um bu 1/t

P.  Wskaznik stanu dla czujnika
(tutaj - zielony) \ ARC View Handheld

O. Warto$¢ pierwszorzednej ——— SIS 35
(gtownej) wielkosci =

wskazywanej przez czujnik \
oraz nazwa tej wielkosci

(tutaj - pH)

/3
N. Wskaznik stanu dla pola

pustego. Tutaj jest on
czerwony, poniewaz pole
nie ma polaczenia z czuj-
nikiem

E. Stan akumulatora

F.  Pole rgcznego monitora
Arc View Handheld
(jest tylko jedno)

G. ID czujnika

g8 — H. Pole czujnika (pokazany
czujnik pH)

I.  Drugorzgdna wielkosé¢
wskazywana przez czujnik
(tutaj - temperatura)

J.  Pole czujnika
(brak podiaczonego
czujnika)

/

© ®

L. Przycisk ,,lewy” (funkcja
pokazana na ekranie, powyzej
przycisku)

K. Przycisk,,prawy” (funkcja
pokazananaekranie, powyzej
przycisku)

M. Przyciski ,,w gorg”
i,,wdot”

Rysunek 1.2: Reczny monitor Arc View z widocznym, gornym poziomem ekranowego interfejsu;
przylaczony czujnik pH
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Symbol pola Funkcja
A. Zegar Zegar czasu rzeczywistego. Pokazuje czas dnia w formacie
24-godzinnym.
Uwaga

Informacje o nastawianiu zegara podano w Zadaniu 2, na str. 41.

B. Poziom obstugi Pokazuje aktualny poziom obslugujacego wybrany czujnik.
Uwaga

Szczegotowe informacje na ten temat podano w punkcie:
»1.5.2 Czujniki Arc: poziomy obstugujacego”, na str. 20.

Na rgcznym monitorze nie wybrano zadnego pola. Taki
przypadek ma miejsce, gdy rgczny monitor zostaje
wlaczony po raz pierwszy.

Pole Arc View Handheld lub wybrane nargcznym
monitorze pole czujnika ma poziom obstugi nastawiony
na Uzytkownik (User).

PoleArc View Handheld lub wybrane nargcznym
monitorze pole czujnika ma poziom obstugi nastawiony
na Administrator.

Pole Arc View Handheld lub wybrane nargcznym
monitorze pole czujnika ma poziom obstugi nastawiony
na Specjalista (Specialist).

Dodatkowo, litera D (do ktorej wymagane jest specjalne hasto)
moze wskazywaé poziom uzywany przez personel serwisu firmy
Hamilton.

C. Numer czujnika | Pierwsza liczba jest numerem czujnika wybranego na recznym
monitorze wedlug kolejno$ci pojawiania si¢ na liscie czujnikéw
aktualnie kontrolowanych przez reczny monitor. Druga liczba
wskazuje catkowita ilo$¢ czujnikdéw kontrolowanych przez reczny
monitor.

Przykladowo: ,,4/7” oznacza, ze wybrano czujnik 4 z listy 7 czujnikéw
wyswietlanych na recznym monitorze.

Uwaga

Nie nalezy myli¢ numeru czujnika z numerem adresowym tego
czujnika jako urzadzenia Modbus lub z ID tego czujnika.
Wigcej informacji mozna znalez¢é w punkcie: ,,1.5.5.2 Adresy
urzadzen Modbus”, na str. 26.

Tabela 1.1: Przyciski i ekran recznego monitora Arc View
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Symbol pola Funkcja

D. Stan potlaczenia Uwaga

bezprzewodowego |Informacje o zachowaniu w przypadku uszkodzenia potaczenia
bezprzewodowego podano w rozdziale: ,,3. Wykrywanie i usuwanie
usterek”.

Prawdopodobnie brak jest komunikacji migdzy recznym
monitorem i wybranym czujnikiem, bezprzewodowe;j
lub przewodowe;j.

Potaczenie bezprzewodowe migdzy recznym monitorem
i wybranym czujnikiem jest stabe lub nie istnieje.
Potaczenie przewodowe, jesli istnieje, jest w porzadku.

Potaczenie bezprzewodowe migdzy recznym monitorem
i wybranym czujnikiem jest niskiej jakosci.

Potaczenie bezprzewodowe migdzy rgcznym monitorem
i wybranym czujnikiem jest sredniej jakosci.

Potaczenie bezprzewodowe migdzy recznym monitorem
i wybranym czujnikiem jest doskonate.

E. Stan akumulatora |Jezeli akumulator r¢cznego monitora wymaga tadowania czgsciej
niz co okoto 5 godzin, nalezy go juz wymienié.

Akumulator natadowany do 1/3.

Akumulator natadowany do 2/3.

Akumulator catkowicie natadowany.

Wit

« Ladowanie akumulatora w stacji dokowania Dock
=~ (wskaznik stanu ciagle si¢ zmienia).

Tabela 1.1: Przyciski i ekran recznego monitora Arc View (ciag dalszy)
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Symbol pola Funkcja
F. Pole rgcznego Ekran uzytkownika r¢cznego monitora jest podzielony na cztery
monitora Arc View |pola widoczne i 27 pél niewidocznych. Jezeli w polu wyswietlany
Handheld jest jaki$ czujnik, czy to widoczny na ekranie, czy tez aktualnie

niewidoczny, to mozna go przesuwa¢ w wybrane potozenic za
pomoca przyciskow ,,w gore” i,,w dot”.

Pole Arc View Handheld znajduje si¢ nad polami czujnikéw
i domyslnie jest niewidoczne po pierwszym wilaczeniu rgcznego
monitora.

Pole Arc View Handheld daje dostgp do ekranow, umozli-
wiajacych konfigurowanie monitora.

G. ID czujnika Jest to fancuch tekstowy, jednoznacznie identyfikujacy wybrany
czujnik. DomyS$Inym nastawieniem fabrycznym ID czujnika jest
jego numer czgsci, po ktéorym nast¢puje numer serii.

H. Pole czujnika Ekran uzytkownika r¢cznego monitora jest podzielony na cztery
pola widoczne i 27 pdl niewidocznych. Jezeli w polu wyswietlany
jest jaki$ czujnik, czy to widoczny na ekranie, czy tez aktualnie
niewidoczny, to mozna go przesuwa¢ w wybrane potozenie za
pomoca przyciskow ,,w gore” i ,,w dot”.

Pole czujnika pokazuje dane pomiarowe czujnika wybranego za
pomoca przyciskow ,,w gorg” i ,,w dot”. Wtedy mozna nacisnaé
przycisk ,,prawy”, aby oglada¢ (View) bardziej szczegdlowe
dane, albo - przycisk ,lewy”, aby uzyska¢ dostep do narzedzi
(Tools)umozliwiajacych kalibrowanie i konfigurowanie danego
czujnika.

I. Drugorzedna Tutaj wyswietlany jest drugorzedny parametr czujnika (temperatura),
wielko$¢ wskazywana | jednostka pomiaru i aktualna warto$¢
przez czujnik

J. Poleczujnika (brak |Ekran uzytkownika r¢cznego monitora jest podzielony na cztery
podiaczonego polawidoczne i 27 p6l niewidocznych. Jezeli w polu wyswietlany
czujnika) jest jaki$ czujnik, czy to widoczny na ekranie, czy tez aktualnie

niewidoczny, to mozna go przesuwa¢ w wybrane potozenic za

pomocg przyciskow ,,w gorg” i ,,w dot”.

To pole jest puste na Rysunku 1.2, poniewaz zaden czujnik nie
jest z nim potaczony. Gdy tylko do systemu Arc zostanie dodany
nowy czujnik, utworzone zostanie automatycznie nowe polaczenie
bezprzewodowe i w omawianym polu zostanie pokazana informacja
o tym czujniku.

Tabela 1.1: Przyciski i ekran recznego monitora Are View (ciag dalszy)
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Symbol pola Funkcja

Funkcje przyciskow ,lewy” i ,,prawy” zaleza od kontekstu. Funkcje sa natychmiast
wskazywane przez oprogramowanie, nad kazdym z przyciskow.

Uwaga
Przyciski ,,lewy” i ,,prawy” nalezy nacisna¢ réwnoczesnie, na trzy sekundy, w celu
wlaczenia recznego monitora.

K. Przycisk ,,prawy” | Nalezy klikna¢ View, aby przegladac informacje dotyczace dowolnego,
wybranego pola. Opcje menu i kolejne ekrany daja dostgp do
struktury szczegotowych informacji.

Nalezy klikna¢ OK, aby zobaczy¢ wigcej ekranow dotyczacych
wybranego pola, albo zatwierdzi¢ wybdr dokonany przyciskami
»W gore” i ,,w dot”.

Nalezy klikna¢ Back, aby cofnaé si¢ w strukturze menu, przeskakujac
w razie potrzeby kilka krokow, do gtownego menu Tools
iView.

L. Przycisk ,,lewy” Nalezy kliknaé Tools, aby uzyskaé¢ dostgp do narzedzi dla
wybranego pola.

Jezeliwybranopole Arc View Handheld,todalsze, pokazywane
ekrany umozliwiajg konfigurowanie r¢cznego monitora.

Jezeli wybrano pole czujnika, to dalsze, pokazywane ekrany
umozliwiaja jego kalibrowanie i konfigurowanie.

Uwaga

Aby wykorzysta¢ niektére z ekrandow menu Tools, trzeba
wprowadzi¢ hasto (patrz: Zadanie 1 na stronie 45 i Zadanie | na
stronie 52).

Nalezy klika¢ [Back arrow] (strzatka ,,wstecz”), aby wrocié
w strukturze menu o jeden krok, za kazdym naci$nigciem.

M. Przycisk ,,w gor¢” | Realizuje przesuwanie (przewijanie) w gorg.

M. Przycisk ,,w dot” | Realizuje przesuwanie (przewijanie) w dot.

Uwaga
Przycisk ,,w dot” naciska sig przez trzy sekundy w celu wytaczenia
rgcznego monitora.

N. Wskaznik stanu dla | Wskazanie stanu: dla pustych pol, nie potaczonych z zadnym
pola pustego czujnikiem, zawsze wyswietlany jest czerwony wskaznik stanu.

Tabela 1.1: Przyciski i ekran recznego monitora Arc View (ciag dalszy)
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Symbol pola Funkcja

O. Warto$¢ pierwszo- | Wielkos¢ fizyczna pokazywana w tym polu zalezy od rodzaju
rzgdnej (glownej) | czujnika:
wielkosci wskazy-
wanej przez czujnik
oraz nazwa tej
wielkosci

o Cond = Przewodno$¢
o pH =pH
o DO = Rozpuszczony tlen

Czujniki Arc moga, oprocz pierwszorzednej, mierzy¢ rowniez
wielko$¢ drugorzedna (jest to zawsze temperatura). Wielkosé
drugorzedna jest pokazywana na prawo od wielkosci pierwszorzedne;.

P. Wskaznik stanu dla | Kolory stanu czujnika, pokazywane na rgcznym monitorze (jak
czujnika ponizej) i kolory stanu na adapterze czujnika Arc Wi, nie maja
identycznego znaczenia. Wigcej informacji mozna znalez¢ w:

o punkcie: ,,1.5.3 Czujniki Arc: stan dzialania”, na str. 21.

o punkcie: ,,3.2Wykrywanieiusuwanieusterek-kolorwskaznika
stanu czujnika na r¢cznym monitorze”, na str. 73.

% Swieci ciagle: czujnik i potaczenie dziata poprawnie.
Pulsuje: aktualizacja danych.

Swieci ciagle: czujnik sygnalizuje btad lub komunikat
ostrzegawczy.
Pulsuje: aktualizacja danych.

. Swieci ciagle: czujnik lub potaczenie nie dziata.

Tabela 1.1: Przyciski i ekran recznego monitora Arc View (ciag dalszy)
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1.4 Zarzadzanie zasilaniem r¢cznego monitora Arc View

Funkcja Dzialanie
Wiaczanie recznego monitora Naciska¢ rownoczes$nie przyciski ,,lewy”
i,,prawy” przez 3 sekundy.
Wylaczanie recznego monitora Naciska¢ przycisk ,,lewy” przez 3 sekundy.
Automatyczne wylaczanie Dziata, gdy reczny monitor jest nieuzywany
rgcznego monitora przez 20 minut.
Uwaga

Specjalista moze zmieni¢ domyslny czas
wylaczenia, 20 minut, na inny, za pomoca
funkcji Power settings dostgpnej w menu
Arc View Handheld - Tools -
Settings.

Resetowanie rgcznego monitora Trzymac nacisnigty przez 30 sekund przycisk
»W dot”.

Automatyczne wylaczanie pod$wietlenia | Dziata, gdy reczny monitor jest nieuzywany
przez 5 minut.

Uwaga

Specjalista moze zmieni¢ domyslny czas
wylaczenia, 5 minut, na inny, za pomoca
funkcji Display settings dostgpnej w menu
Arc View Handheld = Tools =
Settings.

Wzbudzanie rgcznego monitora, Nacisna¢ dowolny przycisk.
gdy podswietlenie jest wylaczone

Tabela 1.2: Funkcje zarzadzania zasilaniem

1.5 Elementy i zasada dzialania systemu Arc

Nalezy dobrze si¢ zaznajomic z nizej opisanymi elementami i zasadami przed przystapieniem
do korzystania z r¢cznego monitora w rzeczywistym srodowisku pracy.
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1.5.1 Czujniki Arc: komunikacja

1.5.1.1 Przeglad
Kazdy czujnik systemu Arc firmy HAMILTON posiada interfejs dwu rodzajow. Mianowicie:

o dwa zlacza interfejsu analogowego 420 mA (za wyjatkiem VISIFERM DO Arc, ktory
ma jedno).

o jedno ztacze interfejsu cyfrowego RS485 Modbus RTU.

Monitor 420 mA J 4+20 mA Modbus PLC cyfrowy
Sygnaty NAMUR

PLC analogowy Komputer

Reczny monitor Arc View Handheld

¥

Rysunek 1.3: Czujnik Arc firmy Hamilton z interfejsem analogowym i cyfrowym

Interfejs analogowy

Dwa wyjscia analogowe czujnika sg przypisane do dwu jego wielkosci mierzonych, w opisany
sposob, podczas fabrycznego konfigurowania czujnika:

o Wyjscie nr 1 interfejsu mA: wielko$¢ mierzona 1 (przewodno$¢, pH lub
rozpuszczony tlen, zaleznie od czujnika),

o Wyjscie nr 2 interfejsu mA: wielkos$¢ mierzona 2(temperatura, z wyjatkiem
czujnika VISIFERM DO Arc, ktéry nie ma
drugiego wyjscia).

Specjalista, jednak, moze zmieni¢ konfiguracje Wyjscie / Wielkos$¢ mierzona, jezeli zachodzi
potrzeba.

Poza tym, zalezno$¢ migdzy warto$cia mierzona przez czujnik, a sygnatem wyjscia interfejsu,
tez moze by¢ konfigurowana przez Specjalistg.
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Wigcej informacji o tych aspektach dziatania interfejsu analogowego zamieszczono w punkcie:
»1.5.6 Czujniki Arc: konfiguracja interfejsu analogowego”, na str. 28.

Potaczenia analogowe migdzy czujnikiem, a urzadzeniem sterujacym, takim jak PLC,
realizowane sa zawsze przewodowo.

Interfejs cyfrowy RS485 Modbus RTU

Wyjscie cyfrowe RS485 Modbus RTU czujnika stuzy do potaczen przewodowych z innym
sprzgtem. Adapter czujnika Arc Wi zamontowany na kazdym czujniku Arc jest konieczny
do potaczen bezprzewodowych i realizuje funkcje radiowe (czujnik wymaga tez, jednak,
osobnego, przewodowego zasilania).

Adapter czujnika
Arc Wi do polaczen ———_ F e

bezprzewodowych m

Kabel sygnatu i zasilania

Ztacze VP8

Czujnik Arc

Rysunek 1.4: Czujnik pH Arc firmy Hamilton, wraz z adapterem czujnika Arc Wi oraz
fkablem

1.5.1.2 Komunikacja czujnika Arc z systemem PLC

Potaczenie z systemem PLC moze by¢ realizowane przez interfejs analogowy lub cyfrowy
czujnika, zaleznie od tego, czy uktad sterowania technologicznego posiada wejscia analogowe,
czy cyfrowe. Jezeli zachodzi potrzeba, interfejs cyfrowy i analogowy moga pracowac
réwnoczesnie.

Ze wzgledow bezpieczenstwa, potaczenie z uktadem sterowania technologicznego jest
zawsze realizowane przewodowo.
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1.5.1.3 Komunikacja czujnika Arc z monitorem r¢cznym

Komunikacja czujnika Arc z monitorem r¢cznym realizowana jest zawsze cyfrowo. Moze
ona odbywac si¢ przewodowo lub bezprzewodowo. Tryb przewodowy jest przydatny do
testowania, sprawdzania i kalibrowania czujnikow poza srodowiskiem technologicznym.
Tryb bezprzewodowy (z wykorzystaniem adaptera czujnika Arc Wi zamontowanego na
czujniku) jest korzystny w $rodowisku pracy.

Domyslnie, komunikacja bezprzewodowa migdzy monitorem r¢cznym i czujnikiem rozpoczyna si¢
automatycznie, z chwilg zdjgcia monitora z jego stacji dokowania (Dock) (Rysunek 1.5).

Rysunek 1.5: Monitor re¢czny rozpoczyna komunikacje¢ bezprzewodowa po zdjeciu ze stacji
dokowania (Dock)

Podobnie, komunikacja bezprzewodowa automatycznie si¢ wyltacza po potozeniu recznego
monitora w jego stacji dokowania (Dock).

Nawet 30 czujnikoéw moze by¢ réwnoczesnie polaczonych z recznym monitorem, ale tylko
cztery (lub mniej), ktore aktualnie wida¢ na ekranie monitora, sg $ledzone aktywnie.

1.5.1.4 Komunikacja czujnika Arc z komputerem

Komputer z darmowym oprogramowaniem Arc Sensor Configurator stanowi pod wielu
wzgledami alternatywe dla monitora recznego: daje nieco wigksze mozliwo$ci funkcjonalne,
ale nie moze pracowaé bezprzewodowo.

Komunikacja czujnika z komputerem zawsze odbywa si¢ za pomoca interfejsu cyfrowego
RS485 Modbus, z uzyciem potaczenia przewodowego. Aby podtaczy¢ czujnik do
komputera, konieczny jest kabel taczacy z jednym z portéow USB komputera oraz adapter
RS485 / USB.
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1.5.2 Czujniki Arc: poziomy obslugujacego

Kazdy czujnik Arc ma zapisana w pamigci warto$¢ poziomu uprawnien aktualnie obstugujace;j
g0 osoby. System Arc uzywa trzech pozioméw obstugujacego (Tabela 1.3).

o Kalibrowanie czujnikow

o Konfigurowanie
czujnikow

o Konfigurowanie rgcznego
monitora

o Zmiana haset dla
poziomdw obstugujacego
AiS

o Aktualizacja oprogra-
mowania sprzgtowego
systemu Arc

o Tworzenie i pobieranie
pliku stanu czujnika

o Tworzenie i pobieranie
profili konfiguracji
czujnika

o Przywracanie nastawien
fabrycznych

Pozu3m Haslo Dopuszczalne dzialania | Dopuszczalne zadania
obslugujacego
Uzytkownik (U) |Nie wymagane |0 Odczyt danych czujnika | o Wszystkie zadania
z punktu: ,,2.2 Zadania
uzytkownika”
Administrator (A) | 18111978 o Odczyt danych czujnika | o Wszystkie zadania
o Kalibrowanie czujnikéw |  z punktu: ,,2.2 Zadania
uzytkownika”
o Wszystkie zadania
z punktu: ,,2.2 Zadania
administratora”
Specjalista (S) 16021966 o Odczyt danych czujnika | o Wszystkie zadania

z punktu: ,,2.2 Zadania
uzytkownika”

o Wszystkie zadania
z punktu: ,,2.2 Zadania
administratora”

o Wszystkie zadania
z punktu: ,,2.2 Zadania
specjalisty”

Dodatkowo, personel serwisowy firmy Hamilton uzy¢ moze poziomu obstugujacego D
(do ktérego wymagane jest specjalne hasto).

Tabela 1.3: Dzialania i zadania dopuszczalne dla réznych pozioméw obslugujacego (podano

domyslne hasta fabryczne)
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Po wlaczeniu czujnika, wraca on do poziomu uprawnien obstugujacego Uzytkownik (U).
Dzieje si¢ tak rowniez, gdy obstugujacy r¢czny monitor opuszcza obszar menu monitora
chroniony hastem.

Wprowadzajac hasto Administratora lub Specjalisty, obstugujacy uzyskuje prawa Admini-
stratora lub Specjalisty (Tabela 1.3).

»Zadanie 1: Nastawianie poziomu obslugujacego Administrator”, na stronie 45
i,,Zadanie 1: Nastawianie poziomu obslugujacego Specjalista”, na stronie 52 wyjasniaja,
jak wprowadza si¢ haslto, aby uzyskac prawa Administratora lub Specjalisty.

1.5.3 Czujniki Arc: stan dzialania
Kolory stanu na r¢gcznym monitorze i adapterze czujnika Arc Wi dotycza:
o Czujnika,

o Potaczenia czujnik / reczny monitor.

Uwaga
o Kolory stanu nie odnosza si¢ do stanu r¢gcznego monitora.

o Kolory stanu na adapterze czujnika Arc Wi nie maja znaczen takich samych jak
na r¢cznym monitorze Arc View.

1.5.3.1 Kolory stanu na r¢cznym monitorze Arc View

Symbol stanu czujnika

- tutaj ma kolor zotty \

W DO 242450-3017

20.62 %o 2225

Rysunek 1.6: Kolory stanu czujnika pokazywane na r¢cznym monitorze Arc View
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Kolor Znaczenie

% Jezeli w polu czujnika éwiepi zielony punkt, to dany czujnik poprawnie przesyta

dane do monitora recznego. Srodek komunikacji (bezprzewodowy lub przewodowy)
i sam czujnik dziataja prawidlowo (pulsowanie zielonego punktu oznacza,
ze monitor r¢ezfny pobiera wiasnie aktualne dane z poprawnie pracujacego
czujnika, czyli wszystko odbywa si¢ normalnie).

== |Jezeli w polu czujnika §wieci zotty punkt, to dany czujnik sygnalizuje stan
%= |ostrzezenia lub bl¢du. Przylaczony czujnik i tacze komunikacyjne dziataja,
ale odczyt czujnika jest prawdopodobnie watpliwy. Na Rysunku 1.6, czujnik DO
mierzy wielkos$¢, ale rownoczes$nie przekazuje sygnal stanu ostrzegania.
Przyczyna tego moze by¢ przyktadowo, niepowodzenie ostatniego kalibrowania.
Dlatego czujnik sygnalizuje, ze jego odczyt jest niedoktadny (pulsowanie zoltego
punktu oznacza, ze monitor r¢gczny pobiera wlasnie aktualne dane z czujnika,
sygnalizujacego stan ostrzezenia lub btedu).

Wigcej informacji o aktywnym ostrzezeniu mozna uzyska¢ przez menu
[Sensor] 2> Tools = Sensor status, gdzie mozna odczyta¢ komunikat
ostrzezenia.

Objasnienia wszystkich komunikatow ostrzezen i blgdow znajduja si¢ w punkcie:
»3.4 Wykrywanie i usuwanie usterek - komunikaty ostrzezen i stanu”,
na stronie 74 i w punkcie: ,,3.5 Wykrywanie i usuwanie usterek - komunikaty
bledéw”, na stronie 79.

. Jezeli w polu czujnika $wieci czerwony punkt, to dany czujnik ma stan nieokreslony.
Czujnik, tacze komunikacji (bezprzewodowe lub przewodowe) lub oba te
elementy nie dziataja.

Tabela 1.4: Znaczenie koloréw stanu na monitorze recznym

Sposdb poprawienia niewlasciwego stanu opisano w punkcie: ,,3.2 Wykrywanie i usuwanie
usterek - kolory stanu czujnika na recznym monitorze”, na stronie 73.

1.5.3.2 Kolory stanu na adapterze Arc Wi czujnika

Uwaga

Kolory stanu na adapterze Arc Wi czujnika nie maja znaczen takich samych jak na
recznym monitorze Arc View. Wigcej informacji na ten temat podano w punkcie:
»1.5.3.1 Kolory stanu na r¢cznym monitorze Arc View”.
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Adapter Arc Wi czujnika moze $wieci¢
na czerwono lub na zielono

Rysunek 1.7: Adapter Arc Wi czujnika

Adapter czujnika Znaczenie

Nie swieci Oznacza to normalny stan czujnika.

Czujnik jest poprawnie podiaczony i dziata normalnie oraz pole
na recznym monitorze Arc View, odpowiadajace danemu czujnikowi nie
jest aktualnie wybrane do obserwacji.

Swieci na zielono Migdzy czujnikiem i monitorem rgcznym przekazywane sa
wilasnie dane.

Czujnik jest poprawnie podlaczony i dziata normalnie, a pole na
r¢cznym monitorze Arc View, odpowiadajace danemu czujnikowi
jest aktualnie wybrane do obserwacji.

Swieci na czerwono Moga by¢ trzy sytuacje, kiedy to zachodzi:

o Dopiero przed chwila wlaczono zasilanie. Adapter Arc Wi
czujnika $wieci tak przez kilka sekund.

o Czujnik nie dziala.

o Czujnik nie jest podlaczony do adaptera Arc Wi.

Tabela 1.5 Znaczenie kolorow stanu na adapterze Arc Wi czujnika

Sposob poprawienia stanu $wiecenia na czerwono opisano w punkcie: ,,3.3 Wykrywanie
i usuwanie usterek - kolory stanu na adapterze Arc Wi czujnika”, na stronie 73.

1.5.4 Czujniki Arc: dwa rodzaje kalibrowania

1.5.4.1 Wprowadzenie

Kalibracja usuwa wpltyw zmian, jakie zachodza w czujniku z uptywem czasu i pod wptywem
zuzycia. Kalibrowanie czujnikéw Arc firmy Hamilton, mozna wykonywac¢ przy uzyciu:

o Regcznego monitora Arc View,

o PC z bezplatnym oprogramowaniem Arc Sensor Configurator,
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o Urzadzenia VisiCal firmy Hamilton,

o Urzadzenia sterowania cyfrowego (PLC lub PC z oprogramowaniem) wykorzystujacego
odpowiednie polecenia protokotu Modbus

Uwaga
W niniejszej instrukcji opis kalibracji ogranicza si¢ do jej realizacji za pomoca
recznego monitora Arc View.

Re¢czny monitor Arc View daje mozliwos¢ wykonania dwu rodzajéw kalibrowania czujnika:
standardowej kalibracji automatycznej oraz kalibracji dla wyrobu.

Przy standardowej kalibracji automatycznej, czujnik jest kalibrowany poza swoim §rodowiskiem
technologicznym, przy uzyciu znormalizowanego medium, dajacego znang warto$¢, z ktora
odczyt czujnika jest porownywany. Przyktadowo, czujnik pH mozna kalibrowa¢ wzgledem
standardowego roztworu o znanym pH, albo czujnik rozpuszczonego tlenu - wzgledem
zawartosci tlenu w powietrzu. Wyrazenie ,,automatyczne” oznacza, ze czujniki Arc maja
zdolno$¢ (z pewnymi ograniczeniami) rozpoznawania wzorca, w ktorym si¢ znajduja
i odpowiedniego, samodzielnego konfigurowania si¢ do kalibracji wzgledem tego wzorca.
Ze spisem wzorcow, odpowiednich do uzycia dla czujnikow Arc, mozna zapoznaé si¢
w: ,,Tabeli 2.2: Wzorce do kalibrowania czujnikow”, na stronie 47.

Przy kalibracji dla wyrobu, czujnik jest kalibrowany w swoim srodowisku technologicznym.
W tym przypadku, odczyt czujnika nastgpuje rownoczesnie z pobraniem probki z badanego
procesu. Probke analizuje si¢ w laboratorium, a wynik wykorzystuje si¢ do skorygowania
odczytu czujnika.

Uwaga

W systemie Arc firmy Hamilton, mozna kalibrowac tylko pierwszorzedna (glowna)
wielko$¢ wskazywana przez czujnik (ilo$¢ rozpuszczonego tlenu dla czujnika DO,
przewodnos¢ dla czujnika Cond, pH dla czujnika pH). Drugorzedna, wskazywana
wielkoscia dla kazdego czujnika Arc jest temperatura, ale nie mozna jej kalibrowac.

1.5.4.2 Teoria kalibrowania

Kalibrowanie czujnikéw Arc rozpuszczonego tlenu i pH odbywa si¢ w dwu punktach kalibracji.
Kalibrowanie czujnikéw Arc przewodnosci wykonuje si¢ tylko w jednym punkcie. Podczas
kalibrowania w kazdym punkcie, czujniki sa poddane dziataniu okreslonego, $cisle regulowanego
srodowiska, a ich odczyty sa kompensowane do znanych warunkow tego §rodowiska.
Przyktadowo, czujnik Arc VISIFERM DO kalibruje sig:

o w $rodowisku 0% tlenu, jako pierwszym punkcie kalibracji,

o w $rodowisku tlenu atmosferycznego, jako drugim punkcie kalibracji.
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Obrazuje to Rysunek 1.8, gdzie dwa punkty kalibracji wyznaczaja krzywa kalibracyjna,
odwzorowujaca luminescencyjne przesunigcie fazowe (surowy wynik pomiaru, zasadni-
czy dla pierwszorzednej wielkos$ci czujnika) dla okreslonej, gtéwnej wielkosci mierzone;,
a mianowicie ilosci rozpuszczonego tlenu.

Ta krzywa stuzy nastepnie do interpretacji wartosci luminescencyjnego przesunigcia fazowego
w czasie pracy czujnika, dla uzyskania doktadnych pomiaréw ilosci rozpuszczonego tlenu.
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Rysunek 1.8: Kalibrowanie pierwszorzednej (gldwnej) wielkosci w dwu punktach dla czujnika

Arc VISIFERM DO

Dla kazdego punktu kalibracji, procedura kalibrowania jest nastgpujaca:

1.

2.

Regczny monitor Arc View wysyla do czujnika Arc polecenie kalibracji.

Oprogramowanie czujnika analizuje dane pomiarowe, zgromadzone w wewngtrznej
pamigci przez ostatnie trzy minuty i, jezeli spelnione sa kryteria stabilno$ci sygnatu,
zakresu kalibracji oraz temperatury, obliczane sa dla danego punktu wartosci kalibracyjne,
ktdre staja si¢ natychmiast aktywne.

Jezeli warto$ci mierzone zmieniaja si¢ lub wzorzec nie zostal rozpoznany, w ciagu
najblizszych okoto 180 sekund podjetych zostanie automatycznie kilka prob kalibracji.

Jezeli mierzone warto$ci staja si¢ stabilne, czujnik podejmuje dziatania opisane w punkcie 2.

Jezeli kalibrowanie nie jest mozliwe przez 180 sekund, procedura kalibracji zostaje
anulowana.
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Uwaga
A o Jezeli kalibracja nie powiodta si¢ w jednym z punktéw kalibrowania, czujnik
nadal moze by¢ uzywany. Mierzona wartos¢ jest jednak niepewna. Wiarygodno$¢
pomiaru jest opisana w polu Quality indicator (wskaznik jakosci), ktore znajduje
si¢ w menu [Sensor] > View = Sensor status.

o Jezeli czujnik nie rozpoznaje wzorca przez ponad 180 sekund od zapoczatkowania
kalibracji, procedura kalibracji zostaje anulowana, z wystaniem odpowiedniego
komunikatu ostrzezenia.

o Jezeli warto$ci mierzone nie sa stabilne przez ponad 180 sekund od zapoczatkowania
kalibracji, procedura kalibracji zostaje anulowana, z wystaniem odpowiedniego
komunikatu ostrzezenia.

o Jezeli kalibracja nie powiodta si¢, wyswietlony zostaje komunikat ostrzezenia.
Wigcej informacji na ten temat podano w punkcie: ,,3.4.3 Komunikaty stanu
kalibrowania”, na stronie 76.

1.5.5 Czujniki Arc: konfigurowanie interfejsu cyfrowego

1.5.5.1 Wprowadzenie

Konfigurowanie interfejsu cyfrowego czujnikéw Arc jest catkiem proste. Dotyczy ono tylko
dwu parametrow:

o Adresu urzadzenia Modbus,
o Szybkosci transmisji.

Uwaga
Interfejs cyfrowy konfiguruje Specjalista z ekranu dostgpnego przez [Sensor] =2
View 2 Interface configuration - Digital RS485.

1.5.5.2 Adresy urzadzen Modbus
Podstawy

Modbus jest cyfrowym protokotem komunikacji szeregowej opracowanym przez firm¢ Modicon
do stosowania z produkowanymi przez nia programowanymi regulatorami logicznymi
(PLC). Stat si¢ on standardowym protokotem komunikacyjnym i jest obecnie powszechnie
dostgpnym sposobem taczenia przemystowych urzadzen elektronicznych.

Firma Hamilton uzywa protokotu Modbus, w ktérym wystgpuje jedno urzadzenie gtowne
(master) (moze nim by¢ PLC Iub rgczny monitor Arc View) i wiele pasywnych urzadzen
podlegtych (slave) (czujniki). Urzadzenie master przesyta adres urzadzenia Modbus,
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aby ustanowic¢ polaczenie komunikacyjne z czujnikiem. Wszystkie czujniki, ktére maja inny
adres, ignoruja ten przekaz.

Protokot Modbus firmy Hamilton jest szczegotowo opisany w ,,Instrukeji programowania
VISIFERM™ DO Modbus RTU”, PN 624179.

Adres urzadzenia Modbus i czujniki

Adres urzadzenia Modbus jednoznacznie identyfikuje czujnik Arc w systemie jego komunikacji
cyfrowej z PLC. Omawiany adres reprezentuje liczba z zakresu od 1 do 30.

Uwaga
Nie nalezy myli¢ adresu urzadzenia Modbus z ID czujnika lub numerem czujnika.
Wigcej informacji o identyfikatorach ID czujnika oraz numerach czujnika, podaja:

o Rysunek 1.2: Reczny monitor Arc View z widocznym, gérnym poziomem
ekranowego interfejsu; przylaczony czujnik pH,

o Tabela 1.1: Przyciski i ekran recznego monitora Arc View.

Domyslnie, kazdy czujnik Arc ma adres urzadzenia Modbus nastawiony na 1. Nastawia si¢
go fabrycznie, przy produkcji czujnika. Z tego wzgledu, nowy adres urzadzenia Modbus
(czyli inny niz 1) trzeba konfigurowa¢ dla kazdego czujnika Arc, ktéry dodaje si¢ do danego
systemu Arc, za pomoca cyfrowego PLC, upewniajac si¢, ze kazdy czujnik w systemie ma
unikalny adres (jezeli dwa czujniki bgda miaty ten sam adres, to na transmisj¢ adresu przez
PLC odpowie tylko szybszy z tych dwu czujnikoéw).

1.5.5.3 Szybko$¢ transmisji

Szybkos¢ transmisji zalezy od potaczenia przewodowego, realizowanego przez interfejs
cyfrowy czujnikow Arc RS485 Modbus.

Oczywiscie, wigksze szybkosci transmisji zapewniaja szybsza komunikacje migdzy czujnikiem
iinnym sprz¢tem. Duze szybkosci transmisji moga prowadzi¢ jednak, w niektorych wypadkach,
do niepewnosci polaczen. Typowym przyktadem jest potaczenie, za pomoca dtugiego kabla,
czujnika z cyfrowym uktadem PLC. Nie mozna wtedy méwi¢ wylacznie o dtugosciach kabla
lub dawac jakie$ w tym wzgledzie zalecenia, poniewaz zmienne czynniki , jak na przyktad
jakos$¢ kabla, albo miejscowe zaktdcenia, maja rownie istotne znaczenie.

Dysponujac cyfrowym systemem PLC, trzeba dos§wiadczalnie znalez¢ najlepsza kombinacj¢
szybkosci 1 niezawodnosci.
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1.5.6 Czujniki Arc: konfigurowanie interfejsu analogowego

Uwaga
Interfejs cyfrowy konfiguruje Specjalista z ekranu dostepnego przez [Sensor] >
View 2 Interface configuration.

1.5.6.1 Wprowadzenie

Wszystkie czujniki Arc maja dwa zlacza interfejsu analogowego (za wyjatkiem VISIFERM DO
Arc, ktory ma jedno). Normalnie, wykorzystuje si¢ jedno ztacze interfejsu analogowego dla
jednej wielko$ci mierzonej. Przyktadowo, domyslnie, czujnik Easyferm Plus wykorzystuje
interfejs mA Nr 1 dla swojej gtownej (pierwszorzednej) wielkosci mierzonej (pH), a interfejs mA Nr 2
dla wielkosci drugorzednej (temperatura).

Zachowywanie nastawien domyslnych nie jest jednak obowiazkowe. Gtowna wielko$é
mierzong mozna skonfigurowac nawet tak, aby byta ona podawana na oba wyjsciowe zlacza
interfejsu analogowego. Potem, kazdy interfejs da si¢ osobno zoptymalizowac, przyktadowo,
Nr 1 dla odczytéw pH w zakresie od pH 3 do pH 4, za$ Nr 2 dla zakresu pH 6 do pH 7.

Czyli, kazdy interfejs analogowy czujnika konfiguruje si¢ niezaleznie.

Uwaga

Konfigurowanie interfejsu analogowego dotyczy obu wielko$ci mierzonych
czujnika w odroznieniu np. od kalibrowania czujnika (dla uzyskania doktadnos$ci
pomiarowej), ktére odnosi si¢ tylko do wielkos$ci pierwszorzednej (patrz punkt:
»1.5.4 Czujniki Arc: dwa rodzaje kalibrowania”, na stronie 23).

Konfigurowanie interfejsu analogowego ma cztery aspekty:

Wybdr kombinacji interfejs/ wielko$¢ mierzona (punkt: ,,1.5.6.2 Przenoszenie parametrow
pomiarowych czujnika do interfejsu analogowego”).

o  Wybdr trybu dziatania interfejsu dla wybranego interfejsu i wielko$ci mierzonej (punkt:
»1.5.6.3 Konfigurowanie trybu interfejsu analogowego™).

o Konfigurowanie pradu wyjscia dla danego trybu dziatania interfejsu (punkt: ,,1.5.6.4 Konfigurowanie
pradu wyj$cia interfejsu analogowego”).

o Konfigurowanie sygnalizacji bledow i ostrzezen dla danego trybu dziatania interfejsu
(punkt: ,,1.5.6.5 Konfigurowanie bledéw i ostrzezen”).
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1.5.6.2 Przenoszenie parametréw pomiarowych czujnika do interfejsu analogowego

Wstep

Specjalista musi najpierw zdefiniowa¢ zalezno$¢ interfejs/ wielko§¢ mierzona, aby moc ja
potem skonfigurowaé. Nalezy pamigta¢, ze czujniki pH i przewodnos$ci maja dwa uklady
interfejsu analogowego, a czujniki rozpuszczonego tlenu — tylko jeden. Oznacza to, ze czujniki
pH i przewodnosci wymagaja przeniesienia dwu zaleznos$ci interfejs/ wielko§¢ mierzona.

Konfigurowanie
Specjalista przenosi parametry do interfejsu przez:

1. Wybor interfejsu analogowego. Realizuje to w menu [Sensor] 2 Tools = Interface
configuration.

2. Wybor wielkos$ci mierzonej, ktora trzeba przenies¢ do wezes$niej wybranego interfejsu
analogowego. Realizuje sig to przez pole Measurement variable w menu [Sensor] 2
Tools 2 Interface configuration 2> mA interface #1[lub #2, lub
mA / ECS-Interface] > Output current configuration.

1.5.6.3 Konfigurowanie trybu interfejsu analogowego

Wstep
Interfejs analogowy moze pracowac na jeden z trzech sposobow:

o Pomiar:
Wyjscie interfejsu 4+20 mA jest funkcja wartosci wielkosci mierzonej, do niego przeniesionej.

o Test:
Wyjsciem interfejsu 420 mA jest wtedy staly sygnat. Mozna to wykorzystaé, przyktadowo,
do sprawdzania petli pradowej 4+20 mA.

o Wylaczony:
Interfejs 4+20 mA nie wysyla sygnatu.

Konfigurowanie

W rzeczywisto$ci, wybor trybu interfejsu analogowego czujnika wymaga, aby pewnych
dalszych wyboréw dokonat Specjalista. Omoéwiono je w punkcie 1.5.6.4.
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1.5.6.4 Konfigurowanie pradu wyjscia interfejsu analogowego

Wstep

Specjalista moze skonfigurowac sposéb, w jaki kazdy interfejs analogowy czujnika przesyta
informacje do systemu PLC. Wykonuje to, definiujac zalezno§¢ miedzy wartoscia wielkosci
mierzonej czujnika (przyktadowo, pH 7) i pradem elektrycznym przesytanym do systemu
PLC (przyktadowo, 10 mA).

Uwaga

A Specjalista konfiguruje prad wyjscia interfejsu analogowego zaczynajac od
[Sensor] 2 Tools = Interface configuration - mA interface
#1 [1lub #2, lub mA / ECS-Interface] > Interface mode.

Konfigurowanie

W punkcie 1.5.6.3, Specjalista decyduje o trybie pracy interfejsu:
o Pomiar,

o Test,

o Wylaczony.

Jezeli Specjalista ma dostosowaé interfejs do pomiardw, to musi on teraz zdecydowac, czy
zalezno$¢ migdzy wartoSciami wielkosci mierzonej i pradem wyjscia jest okreslona przez dwa
punkty, jako wykres prostoliniowy, czy tez za pomoca trzech punktéw - 1 ma postaé¢ wykresu
ztozonego z dwu odcinkéw. Te opcje nazywane sa: 4+20 mA linear (liniowa 4+20 mA) oraz
4+20 mA bilinear (dwuliniowa 420 mA) i sa objasnione w Tabeli 1.6, na stronach 31-33.

Jezeli Specjalista chee dostosowac interfejs do celow testowania, wybra¢ musi opcje¢ 420 mA
fixed (4+20 mA ustalone), tez pokazana w Tabeli 1.6, na stronach 31-33.

Jezeli Specjalista nie potrzebuje interfejsu, nastawia opcj¢ OFF.

Jezeli Specjalista chce uzy¢ interfejsu do pomiarow, musi teraz skonfigurowa¢ wartosci do
zaleznosci (liniowej lub dwuliniowej), ktora wybrat. Jezeli ma uzy¢ trybu testowego, musi
zdefiniowac dla tego trybu stata wartosc.

Uwaga

Specjalista konfiguruje warto$ci przez menu [Sensor] > Tools >
Interface configuration 2> mA interface #1[lub #2, lub mA /
ECS-Interface] 2 Output current configuration.
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Zadaniem Specjalisty jest takie skonfigurowanie sygnatu czujnika, wysylanego do
analogowego PLC, aby uwypukli¢ zakres pomiarowy, ktory dla uzytkownika jest najwazniejszy.
Przyktadowo, jezeli pH w procesie technologicznym miesci si¢ stale w zakresie pH 4 do pH 6,
to Specjalista konfiguruje sygnat dla tego zakresu, pozwalajac, aby warto$ci mierzone spoza
pH 4 do pH 6 znalazty si¢ poza zakresem 4+20 mA interfejsu analogowego.

Tryb Objasnienie
OFF (wylaczony) Interfejs analogowy jest wytaczony. Nie sg wysytane zadne
sygnaly.
4+20 mA fixed Interfejs wysyta ciagly, ustalony sygnat do celow testowania.

(4+20 mA ustalone)
Uwaga

Specjalista konfiguruje ten staly sygnat testowy przez menu
[Sensor] = Tools = Interface configuration =2
mA interface #1 [lub #2, 1lub mA /
ECS-Interface] = Output current configuration.

4+20 mA linear Wykonuje si¢ konfigurowanie interfejsu przy uzyciu dwu punktow.
(liniowy 4+20 mA) W tym sposobie konfigurowania, omawiane dwa punkty stanowig
konce prostoliniowego wykresu, okreslajacego zalezno$¢ migdzy:

o Warto§ciami zmierzonymi przez czujnik, umieszczony
w medium technologicznym, np. wartosciami DO, oraz

o Wartosciami wyjscia interfejsu 4+20 mA, taczacego z uktadem
regulacji procesu technologicznego.
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Tabela 1.6: Obja$nienia trybéw interfejsu, konfigurowanych przez menu [Sensor] > Tools >
Interface configuration - mA interface #1 [lub #2, lub mA /
ECS-Interface| 2 Interface mode

31



INTROL Sp. z o.0., ul. Ko$ciuszki 112, 40-519 Katowice, tel.: 32/78 90 067, faks: 32/78 90 010, e-mail: fizchem@introl.pl, www.introl.pl

Tryb Objasnienie
4+20 mA linear Powyzszy rysunek pokazuje dwa mozliwe wykresy prostoliniowe,
(liniowy 420 mA) okreslajace zaleznosci migdzy warto§ciami mierzonymi czujnika

VISIFERM DO Arc i pradem wyjscia interfejsu. Wykresy dotycza
rozpuszczonego tlenu i temperatury (obie wielko$ci nie moga by¢
réwnoczesnie przeniesione na jeden uktad interfejsu analogowego).

Uwaga

Specjalista wprowadza wartosci dla kazdego konca wykresu przez
menu [Sensor] = Tools = Interface configuration =
mA interface #1 [lub #2, lub maA /
ECS-Interface] = Output current configuration.

4+20 mA bilinear Tutaj konfigurowanie interfejsu odbywa si¢ przy uzyciu trzech
(dwuliniowy 4+20 mA) | punktow. W tym sposobie konfigurowania, omawiane trzy punkty
definiuja dwa prostoliniowe odcinki, tworzace wykres zaleznosci
miedzy:

o Warto§ciami zmierzonymi przez czujnik, umieszczony
w medium technologicznym, np. wartosciami DO, oraz

o Wartosciami wyjscia interfejsu 4+20 mA, faczacego z uktadem
regulacji procesu technologicznego.
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Tabela 1.6: Objasnienia trybéw interfejsu, konfigurowanych przez menu [Sensor]| - Tools >
Interface configuration > mA interface #1 [lub #2, lub mA /
ECS-Interface| 2 Interface mode (ciag dalszy)
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Tryb Objasnienie

4+20 mA bilinear Powyzszy rysunek pokazuje dwa mozliwe wykresy, okreslajace
(dwuliniowy 4+20 mA) | zalezno$ci miedzy wartosciami mierzonymi czujnika VISIFERM DO Arc
i pradem wyjscia interfejsu. Wykresy dotycza rozpuszczonego
tlenu i temperatury.

Uwaga

Specjalista wprowadza wartosci dla kazdego konca wykre-
su oraz jego punktu $rodkowego przez menu [Sensor]
2> Tools > Interface configuration -
mA interface #1 [lub #2, lub maA /
ECS-Interface] = Output current configuration.

Tabela 1.6: Obja$nienia trybéw interfejsu, konfigurowanych przez menu [Sensor] - Tools >
Interface configuration > mA interface #1 [lub #2, lub mA /
ECS-Interface| > Interface mode (ciag dalszy)

1.5.6.5 Konfigurowanie bledow i ostrzezen

Wstep

Specjalista moze skonfigurowaé sposob, w jaki kazdy interfejs analogowy czujnika bedzie
sygnalizowal elektronicznie stan blgdu lub ostrzezenia dla systemu PLC. Dodatkowo,
Specjalista moze zdefiniowaé parametry dla stanu ostrzezenia i biedu.

Uwaga

Specjalista konfiguruje btedy i ostrzezenia korzystajac zmenu [Sensor] =2 Tools >
Interface configuration 2> mA interface #1[lub #2] > Error
warning configuration.

Konfigurowanie

Zakres parametréw dostgpnych do skonfigurowania zalezy od rodzaju czujnika oraz
wyboréw dokonanych wedlug opisu punktu: ,,1.5.6.3 Konfigurowanie trybu interfejsu
analogowego”.

Pelny spis pol jest uwidoczniony w menu, pod [Sensor] = Tools = Interface
configuration 2?mA interface #1[lub #2]> Error warning configuration.
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1.5.7 Czujniki Arc: oczyszczanie i sterylizacja w miejscu pracy

System Arc pomaga realizowa¢ oczyszczanie w miejscu pracy (Cleanings In Place - CIP)
oraz sterylizacj¢ w miejscu pracy (Sterilizations In Place - SIP).

Uwaga

Kazdy obshugujacy moze zapoznac sig, a Specjalista moze konfigurowac definicje
i sumaryczng ilos¢ CIP oraz SIP dla czujnika. Korzysta w tym celu z menu [Sensor] =2
Tools 2 Calibrration 2 Calibration data.

Jak wskazuja nazwy, CIP i SIP sa dziataniami w ktorych czujnik jest oczyszczany
i sterylizowany bez jego demontazu z instalacji technologicznej. Typowe definicje CIP i SIP
przedstawiono ponizej:

Temp. min. Temp. max. Czas
C1p 80°C 100°C 30 min.
SIP 120°C 130°C 30 min.

Tabela 1.7: Typowe definicje CIP i SIP

Kazdy czujnik Arc automatycznie zlicza ilos¢ operacji CIP i SIP, ktorym zostat poddany,
a ich sum¢ wewngtrznie zapamigtuje. Zaleznie od tego, czy CIP lub SIP osiagngty zadane
parametry, czujnik decyduje, ze dziatanie CIP lub SIP odbyto sig, albo - nie. Rysunek 1.9
pokazuje zapisy czujnika dla CIP i SIP zdefiniowanych w Tabeli 1.7.
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Rysunek 1.9: Sposéb zliczania CIP i SIP przez czujniki Arc
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o Przypadek 1: Czujnik nie zarejestrowal SIP, poniewaz czas trwania byt za krotki dla
spelnienia warunku definicji SIP z Tabeli 1.7.

o Przypadek 2: Czujnik zarejestrowatl CIP, poniewaz czas i temperatura miescity si¢
w zdefiniowanym zakresie.

o Przypadek 3: Czujnik nie zarejestrowat CIP, poniewaz poniewaz temperatura wzrosta
powyzej maksimum dla CIP. Zamiast tego, w punkcie 4 zarejestrowana
zostata SIP.

o Przypadek 4: Czujnik zarejestrowal SIP, poniewaz czas i temperatura miescily si¢
w zdefiniowanym zakresie.

Zaréwno CIP, jak i SIP powoduja zuzycie czujnikdw i sa glownym czynnikiem ograniczajacym
ich zywotnos¢, co dotyczy czujnikow wszystkich producentow. Typowo, czujniki wytrzymuja
50 do 100 operacji CIP i SIP, w zaleznosci od temperatury oraz czasu trwania tych dziatan,
a takze od tego, czy rownoczesnie sq uzywane $rodki czyszczace badz sterylizujace.

Jak wskazuje doswiadczenie, obstugujacy powinien taczy¢ informacj¢ podawana
w [Sensor] = Tools > Measurement - CIP / SIP definition, adotyczaca
liczby dziatan CIP i SIP, ktorym czujnik zostat poddany, z wiedza o rodzaju stosowanych
CIP i SIP, a na tej podstawie wnioskowaé w przyblizeniu o pozostalym czasie przydatno$ci
swoich czujnikow.

1.5.8 Pomiary z uzyciem czujnika Arc: ruchoma $rednia

Srednia ruchoma polega na wyborze swego rodzaju ,,okna czasowego”, w ktorym czujnik
sledzi ubiegle wyniki do chwili biezacej, usredniajac je w ramach tego okna. Obserwacja
odczytow usrednionych moze by¢ korzystna, gdy rzeczywiste wyniki silnie si¢ zmieniaja.
Wyniki usrednione sg lepszym wskaznikiem podstawowego trendu zmian, niz wiele wynikow
szybko si¢ zmieniajacych.

Uwaga
A o Specjalista dokonuje nastawien sredniej ruchomej dla czujnika, korzystajac z menu
[Sensor] = Tools = Measurement.

o Nienalezy myli¢ odczytu (ktorych wiele sktada sig na srednia ruchoma) z wartoscia
rozdzielczosci (tylko dla VISIFERM DO Arc). Rozdzielczos¢ objasniono
w punkcie: ,,1.5.9 Pomiary z uzyciem czujnika Arc: rozdzielczo$¢”.

o Srednie ruchome doktadnie opisano w: ,Instrukeji programowania
VISIFERM™ DO Modbus RTU”, PN 624179.
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Srednia ruchoma poprawia stabilnosé sygnatu w krétkim okresie. Wydtuza sig jednak (pogarsza)
czas odpowiedzi czujnika przy zwigkszaniu jej okresu. Przykladowo, VISIFERM DO Arc oblicza
nowy odczyt zawarto$ci tlenu co 3 sekundy. Mozna wygladzi¢ jego odczyty, korzystajac ze
$redniej ruchomej (Rysunek 1.10, ponizej na stronie 36). Zastosowanie $redniej ruchomej do
20 trzysekundowych odczytéw zwigkszy jednak czas odpowiedzi przynajmniej do 60 sekund.
Specjalista moze nastawic¢ liczbg odczytow do obliczania $redniej ruchomej migdzy 1 a 16
(dla czujnikéw pH i przewodnosci) lub od 1 do 30 (dla czujnikéw DO). Moze tez wprowadzié
wartosc¢ zero (0), aby aktywowac tryb automatyczny dla $redniej ruchomej, w ktérym czujnik
zmienia to nastawienie, zaleznie od trendu sygnatu pomiarowego.

1.5.9 Pomiary z uzyciem czujnika Arc: rozdzielczo$¢

W odniesieniu do pomiaréw za pomoca czujnikow Arc, okreslenie ,,rozdzielczo$¢”
dotyczy liczby pojedynczych pomiaréw, tworzacych zapisany wynik pomiarowy czujnika
VISIFERM DO Arc. Okre$lenia tego nie uzywa si¢ do innych rodzajow czujnikéw, dlatego
tez pole Resolution (rozdzielczos¢) jest dostgpne na rgcznym monitorze tylko dla czujnikow
rozpuszczonego tlenu.

Uwaga
Specjalista nastawia rozdzielczo$¢ dla czujnika VISIFERM DO Arc, korzystajac
zmenu[Sensor] = Tools = Measurement.

Wplyw uzycia $redniej ruchomej (n=1in = 20)
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Rysunek 1.10: Poréwnanie odpowiedzi VISIFERM DO Arc na zmiang¢ powietrza na azot przy
zastosowaniu n = 1 (bez Sredniej ruchomej) oraz dla Sredniej ruchomej odpowia-
dajacej n =20

Pomiar wykonywany przez VISIFERM DO Arc w kazdym 3-sekundowym przedziale jest
w rzeczywistos$ci $rednia, nawet do 16 pomiarow sktadowych (Rysunek 1.11, na stronie 37).
Specjalista moze nastawi¢ liczbg pomiaréw sktadowych od 1 do 16. Moze tez wprowadzic¢
wartos¢ zero (0), aby aktywowac tryb automatyczny dla sredniej ruchomej, w ktorym czujnik
zmienia to nastawienie, zaleznie od trendu sygnatu pomiarowego.
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Wplyw roznej rozdzielczosci (1 i 16) na stabilno$¢ (w obu przypadkach $rednia
ruchoma jest obliczana dlan = 1)
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Rysunek 1.11: Poréwnanie stabilno$ci sygnatu VISIFERM DO Are przy zastosowaniu rozdzielczosci 1 16

Korzyscia ze stosowania nizszej rozdzielczoscei jest krotszy okres ekspozycji luminoforu
na $wiatto wzbudzajace. Zmniejsza to blaknigcie optyczne luminoforu, czyli zwigksza jego
zywotnos¢, a zatem — réwniez zywotnos¢ czujnika. Pozytkiem, jaki uzyskuje si¢ stosujac
wyzsza rozdzielczo$¢ jest poprawa jakosci sygnatu.

1.5.10 Pomiary z uzyciem czujnika Arc: wspolczynnik kompensacji temperatury

W odniesieniu do pomiaréw za pomoca czujnikow Arc, okreslenie ,,wspotczynnik
kompensacji temperatury” dotyczy nastawienia, ktore wykona¢ moze Specjalista, dla
uzyskania poréwnywalnosci pomiarow przewodnosci wykonanych w roznych temperaturach.
Zapewnia ono przeliczenie przewodnosci probki do ogélnie przyjetej temperatury odniesienia (25°C).
Pole Temp. comp. Factor jest dostgpne na regcznym monitorze tylko dla czujnikow
przewodnosci.

Uwaga
Specjalista nastawia wspotczynnik kompensacji temperatury dla czujnika Conducell 4USF,
korzystajac z menu [ Sensor] = Tools = Measurement.

Wspotczynnik kompensacji temperatury jest to szybkos¢ z jaka przewodnos$¢ roztworu
wzrasta przy wzroscie temperatury i wyraza si¢ jako procentowy przyrost przewodnosci na
przyrost temperatury o 1°C. Wybrany przez Specjaliste wspotczynnik musi by¢ dostosowany
do rodzaju cieczy, ktora kontroluje czujnik.
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1.5.11 Pomiary z uzyciem czujnika Arc: wskaznik jakoS$ci

W odniesieniu do pomiaré6w za pomoca czujnikow Arc, parametr ,,wskaznik jakosci” dotyczy,
wybieranego przez czujnik, okreSlenia oceniajacego wiarygodno$¢ wartosci jego pierwszorzednej
wielkos$ci mierzonej: przewodnos$ci, pH lub zawartos$ci rozpuszczonego tlenu (ale nie
temperatury, ktora jest wielkoscia drugorzedna). Pole Quality indicator jest dostgpne na
recznym monitorze dla wszystkich czujnikow Arc i opisuje stan czujnika za pomoca sze$ciu
okreslen: Excellent (doskonatly), High (dobry), Acceptable (akceptowalny), Poor
(staby), Very Poor (bardzo staby), Defective (uszkodzony).

Uwaga
Kazdy obstugujacy moze sprawdzi¢ wskaznik jakosci swego pomiaru, korzystajac
zmenu|[Sensor] 2 View = Sensor status.

Obliczanie wskaznika jakosci dla danego czujnika uwzglednia wiele czynnikow, z ktorych
niektore sg specyficzne dla rodzaju czujnika, a inne maja charakter ogdlny. Warunki specyficzne
dla poszczegdlnych rodzajow czujnikow, to:

o Czujniki rozpuszczonego tlenu: stan luminoforu - ciagle monitorowany.
o Czujniki pH: po kalibracji sprawdza si¢ potozenie zera (0) i nachylenie krzywej kalibrowania pH.
o Czujniki przewodnosci: po kalibracji sprawdza sig stalg celi czujnika.

Czynniki ogolne do obliczania wskaznika jakosci, to:

o Jako$¢ uzyskana w wyniku ostatniego kalibrowania.

Jezeli kalibracja nie udaje si¢ w jednym z punktow i generowany jest komunikat ostrzezenia,
nie oznacza to koniecznie, ze czujnika nie mozna uzywac. W przypadku niepowodzenia
w pewnym punkcie kalibracji, czujnik uzywa danych z ostatniego, udanego kalibrowania,
ale wskaznik jakosci moze by¢ obnizony.

o Poniewaz doktadnos$¢ i wiarygodno$é kazdego czujnika maleje w miar¢ uzywania:
o Uwzglednia sig liczbg oczyszczen czujnika w miejscu pracy (Cleanings In Place - CIP),

o Uwzgledniasig liczbe sterylizacji czujnika w miejscu pracy (Sterilizations In Place - SIP)
(Wigcej informacji o CIP i SIP podano w punkcie: ,,1.5.7 Czujniki Arc: oczyszczanie
i sterylizacja w miejscu pracy”, na stronie 34).

o Liczba godzin pracy w roznych temperaturach.
(Taka statystyke mozna sprawdzi¢ przezmenu [Sensor] = View = Sensor status >
Total operating hours).
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1.6 Podstawowy interfejs uzytkownika re¢cznego monitora Arc

Poczynajac od oprogramowania sprz¢towego w wersji 026, rgczny monitor systemu Arc
View Handheld oferuje funkcjg ,,podstawowy interfejs uzytkownika” (tzw. ,,simple mode”
- tryb uproszczony). Jego zaleta jest utatwienie korzystania z r¢cznego monitora Arc View
przez eliminacj¢ wigkszosci ekranéw konfiguracyjnych. Jest to zalecane dla zastosowan,
w ktorych nie ma potrzeby zmian konfiguracji.

Uzytkownik poziomu Specjalisty moze aktywowac podstawowy interfejs uzytkownika
przez menu: Arc View Handheld - Tools > Settings = User interface.
Podstawowy interfejs uzytkownika dziata dla wszystkich czujnikow.

Zmiany wzglgdem standardowego interfejsu graficznego:
o [Sensor] = Tools = Measurement:
o Usunigcie nastawien glownej wielkosci mierzone;.
o Usunigcie parametrow pomiaru.
o Usunigcie definiowania CIP / SIP.
o Usunigcie korekty CIP (tylko dla optycznych czujnikow tlenu).

o [Sensor] = Tools = Calibration: bez zmian.

o [Sensor] = View = Sensor status oraz [Sensor]—> Tools = Sensor
status: bez zmian.

o [Sensor] = Tools = Data management: catkowicie usunigte.

o [Sensor] 2 View=> Sensor infooraz [Sensor] 2 Tools = Sensor info:
catkowicie usunicte.
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2. Objasnienia zadan re¢cznego monitora

Ten rozdzial zawiera wprowadzenie do gléwnych zadan, ktére obstugujacy - Uzytkownik,
Administrator lub Specjalista - realizuje normalnie na bazie Systemu Arc firmy Hamilton,
przy uzyciu recznego monitora Arc View Handheld.

2.1 Wstep

Ten punkt ma prowadzi¢ uzytkownika przez pewne zadania, ktére wykonuje on codziennie
w systemie Arc. Przed zaznajomieniem si¢ z trescig tego rozdziatu, trzeba zrozumie¢ réznice
migdzy poziomami dostgpu, jakie do Systemu Arc ma Uzytkownik, Administrator i Specjalista.
Informacje te mozna znalez¢ w punkcie: ,,1.5.2 Czujniki Arc: poziomy obslugujacego”,
na str. 20.

Administratorzy i Specjalisci musza wprowadzi¢ odpowiednie hasto, aby wykonywa¢ zadania
poziomu Administratora lub Specjalisty.

2.2 Zadania Uzytkownika

Uzytkownik ma najnizszy poziom dostgpu do systemu Arc ze wszystkich obstugujacych:
moze on (lub ona) jedynie sprawdza¢ stan Systemu i odczytywac wyniki pomiaréw wykonanych
przez czujniki systemu.

Zadanie 1: Sprawdzanie stanu wszystkich czujnikow w systemie Arc
o Wstep

Re¢czny monitor moze jednoczes$nie wyswietlaé dane tylko czterech (lub mniej) czujnikow,
ktore caly czas aktywnie monitoruje. Dane kazdego z tych czujnikdéw sa pokazywane w polu
przegladania danych, zawierajacym informacje o typie czujnika, parametrach, wartosciach
odczytow pomiarowych i stanie czujnika. Jezeli wszystko dziata poprawnie, wskaznik stanu
ma kolor zielony. Pulsowanie zielonego wskaznika sygnalizuje, ze r¢czny monitor aktualizuje
swoje dane z dobrze dzialajacego czujnika (Rysunek 2.1).

Wskaznik stanu w polu przegladania danych
czujnika. Tu jest on zielony, sygnalizujac, —D pH
ze czujnik dziata poprawnie. Pulsowanie na

zielono oznacza aktualizowanie danych. 4.10

242111-1048

pH 2667°C

Rysunek 2.1: Wskaznik stanu czujnika (u gory pola, na ekranie recznego monitora)
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o Dzialania

1. W razie potrzeby, wlaczy¢ reczny monitor naciskajac rownocze$nie przyciski ,,lewy”
i,,prawy” przez 3 sekundy.

2. Jezeli reczny monitor jest juz wlaczony, nalezy naciskaé przycisk ,,lewy” az do osiagnigcia
gbérnego poziomu ekranowego interfejsu, gdzie widoczne sa pola przegladania danych
(Rysunek 1.2: Reczny monitor Arc View z widocznym, gornym poziomem ekranowego
interfejsu; przytaczony czujnik pH, na stronie 10).

3. Sprawdzi¢ stan czujnikéw wyswietlanych na ekranowym interfejsie. Wszystkie wskazniki
stanu przytaczonych czujnikéw musza by¢ zielone lub zotte (Rysunek 2.1).

4. Korzystajac z przyciskow ,lewy” i ,,prawy”, przesuwac (przewijac) interfejs ekranowy,
aby sprawdzi¢ rowniez stan czujnikow poczatkowo niewidocznych na ekranie.

5. Jezeli wskaznik stanu ktoregos z czujnikoéw ma kolor z6lty, nalezy odczytaé towarzyszacy
komunikat ostrzezenia lub btgdu, aby stwierdzi¢ przyczyng, a nastgpnie poprawic sytuacje.
Informacje na ten temat zawiera podzadanie: ,,3.1 Odczytywanie danych o stanie
czujnika”, na stronie 43.

o Komentarz

Przy przewijaniu, aby zobaczy¢ czujnik aktualnie niewidoczny na ekranie, trzeba poczekad na
ustanowienie nowego polaczenia (przewodowego lub bezprzewodowego) migdzy czujnikiem
1 rgcznym monitorem. Moze to trochg potrwaé (polaczenie migdzy czujnikiem i technolo-
gicznym uktadem regulacji nie zmienia si¢ w tym czasie).

Zadanie 2: Odczytywanie wartosSci gldwnej (pierwszorzednej) wielkoS$ci
mierzonej czujnika

Podzadanie 2.1: Odczytywanie wartosci gldéwnej wielkoSci w postaci liczbowej

Wartosci wielko$ci mierzonej czujnika w postaci liczbowej odczytuje si¢ w polu tego czujnika
na ekranowym interfejsie r¢cznego monitora, jak to pokazano w: ,,Zadanie 1: Sprawdzanie
stanu wszystkich czujnikow w systemie Arc”.

Podzadanie 2.2: Odczytywanie wartosci gléwnej wielkoSci w postaci graficznej
o Wstep

Przy uzyciu recznego monitora Arc View mozna obserwowacé przebiegi danych w wybranych
okresach czasu, tak samo, jak wartosci liczbowe wynikéw w czasie rzeczywistym. W tym
celu nalezy otworzy¢ wykres, zgodnie z objasnieniami w Dziatania, ponizej.
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]

1.

m}

Dzialania
Wybraé zadany czujnik na gldéwnym (poczatkowym) poziomie interfejsu ekranowego.

Klika¢ View = Graph - OK.
Pojawi si¢ wykres podobny do pokazanego na Rysunku 2.2.

Przy uzyciu przyciskéw ,,w gorg” i,,w dot”, wybra¢ odpowiednia skalg osi X (powigkszanie
lub pomniejszanie). Dostgpne sa trzy skale: 1 minuta, 10 minut i 100 minut.

Wybraé Auto, aby automatycznie dobrac¢ skalg osi Y.

Komentarz

Wykres zaczyna si¢ tworzy¢ od razu po kliknigeiu OK.

Szczegodty wykresu zalezne sa od rodzaju czujnika, ktorego dane sa wyswietlane.

Dla obstugujacego z poziomu S, dodatkowo, w tytule ekranu wys$wietlana jest nazwa pliku
obserwacyjnego.

Wigcej informacji o plikach obserwacyjnych mozna znalez¢ w: ,,Zadanie 5: Zarzadzanie
plikami obserwacyjnymi”, na stronie 62.

Rysunek 2.2: Wykres dla czujnika przewodnosci, pokazywany w trybie U lub A
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Zadanie 3: Odczytywanie danych szczegélowych z czujnika
o Wstep

Tak samo jak odczytuje si¢ z czujnika wyniki pomiaréw, mozna odczytywa¢ wiele innych
danych dodatkowych. Mieszcza si¢ one w kategoriach:

o Stan czujnika
Dotyczy wskaznika jako$ci czujnika oraz biezacych probleméw zwiazanych z czujnikiem.

o Informacje o czujniku
Dotyczy identyfikacji czujnika: ID czujnika, nazwa czujnika, numer cz¢$ci, numer serii,
wersja oprogramowania i porzadek pracy.

o Konfiguracja interfejsu
Dotyczy sposobu, w jaki Specjalista nastawil interfejs cyfrowy i analogowy dla wybranego
czujnika.

Podzadanie 3.1: Odczytywanie danych o stanie czujnika
o Wstep
Istnieje pi¢¢ rodzajow danych dla stanu czujnika:

o Sumaryczna liczba godzin pracy w catym okresie uzytkowania czujnika. Dzieli si¢ ona
na dwie kategorie:

o praca z maksymalna temperatura pomiaru powyzej 85°C,

o praca z maksymalng temperaturg pomiaru powyzej 135°C.
(Naturalnie, kategoria godzin pracy powyzej 85°C obejmuje tez wszystkie godziny pracy
powyzej 135°C).

o Liczba dziatan oczyszczania w miejscu pracy (CIP) oraz sterylizacji w miejscu pracy (SIP),
jakim poddany byt czujnik w calym okresie uzytkowania.

o Komunikaty ostrzezen, zwiazane z stanem ostrzegania czujnika.
o Komunikaty blgdow, zwigzane z stanem bigdu czujnika.

o Wskaznik jako$ci.

43



INTROL Sp. z o.0., ul. Ko$ciuszki 112, 40-519 Katowice, tel.: 32/78 90 067, faks: 32/78 90 010, e-mail: fizchem@introl.pl, www.introl.pl

o Dzialania
1. Wybra¢ zadany czujnik na gtéwnym (poczatkowym) poziomie interfejsu ekranowego.

2. Klika¢ Vview = Sensor status.

Podzadanie 3.2: Odczytywanie informacji o czujniku
o Wstep

Znajduja si¢ tu wszystkie informacje, jakich mozna by oczekiwac: nazwa czujnika, numer
czegsci, numer serii oraz inne, wspomniane. Stuza one do precyzyjnej identyfikacji danego
czujnika.

o Dzialania
1. Wybra¢ zadany czujnik na gldéwnym (poczatkowym) poziomie interfejsu ekranowego.

2. Klika¢ View = Sensor info.

Podzadanie 3.3: Odczytywanie danych o konfiguracji interfejsu

Wszystkie czujniki Arc maja dwa uktady interfejsu analogowego, za wyjatkiem czujnika
rozpuszczonego tlenu VISIFERM DO Arc, ktory ma tylko jeden taki interfejs (oraz
standardowy interfejs cyfrowy Arc).

Zadaniem Specjalisty jest skonfigurowanie uktadow interfejsu odpowiednio do systemu
sterowania technologicznego. Uzytkownik nie moze tu dokonywac zadnych zmian.

o Dzialania
1. Wybra¢ zadany czujnik na gtéwnym (poczatkowym) poziomie interfejsu ekranowego.

2. Klika¢ View = Interface configuration.

2.3 Zadania Administratora

System Arc firmy Hamilton wyrdznia trzy stopnie uprawnien obshugujacego: Uzytkownik,
Administrator i Specjalista. Szerszy opis tego tematu mozna znalez¢ w punkcie:
»1.5.2 Czujniki Arc: poziomy obslugujacego”, na stronie 20.

Oprocz swoich wilasnych zadan, Administrator moze wykonywaé wszystkie zadania
Uzytkownika.
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Uwaga

Przed zapoznawaniem sig z dalsza trescia tego punktu, nalezy koniecznie, dobrze
pozna¢ zadania Uzytkownika (patrz punkt: ,,2.2 Zadania Uzytkownika”,
na stronie 40).

Zadanie 1: Nastawianie poziomu obshlugi dla Administratora
o Wstep

Aby wykonywa¢ zadania Administratora, obstugujacy musi najpierw wprowadzi¢ hasto
Administratora. Objasniono to bezposrednio ponize;.

o Dzialania

1. W razie potrzeby, wlaczy¢ reczny monitor naciskajac rownocze$nie przyciski ,,lewy”
i,,prawy” przez 3 sekundy.

2. Jezeli rgczny monitor jest juz wlaczony, nalezy naciskac przycisk ,,lewy” az do osiagnigcia
gbérnego poziomu ekranowego interfejsu, gdzie widoczne sa pola przegladania danych
(Rysunek 1.2: Reczny monitor Arc View z widocznym, gornym poziomem ekranowego
interfejsu; przylaczony czujnik pH, na stronie 10).

3. Wybraé czujnik, ktérego maja dotyczyé przewidziane dziatania.
4. Kliknaé Tools.
5. Wybraé¢ A w przypadku Administratora.

6. Klikna¢ OK i wprowadzi¢ nastepujace hasto: 18111978

Uwagi
A o Wyzej wskazane hasto jest fabrycznym hastem domyslnym dla Administratora.
Mozna je zmieni¢ przy uzyciu bezptatnego oprogramowania Arc Sensor
Configurator.

o Zawsze, gdy reczny monitor wylacza si¢ automatycznie lub zostaje
wylaczony recznie, albo, gdy obstugujacy wraca do gérnego poziomu ekrano-
wego interfejsu, czujnik domyslnie wraca do trybu obstugi przez Uzytkownika.
Jednakze, jezeli przy powrocie do gornego poziomu ekranowego interfejsu,
obshugujacy wyraznie potwierdzi, ze chce on, lub ona, zachowa¢ hasto, przy
uzyciu ktérego wszedt, to rgczny monitor zapamigta hasto. W takim wypadku,
gdy uzytkownik kliknie Tools, aby uzyskaé¢ dostgp do funkcji chronionych
hastem, musi on, lub ona, tylko potwierdzi¢ hasto (bez ponownego wprowadzania).

45



INTROL Sp. z o.0., ul. Ko$ciuszki 112, 40-519 Katowice, tel.: 32/78 90 067, faks: 32/78 90 010, e-mail: fizchem@introl.pl, www.introl.pl

Zadanie 2: Kalibrowanie czujnika
o Wstep

Gdy jest mowa o kalibrowaniu czujnika, oznacza to kalibrowanie tylko pierwszorzednej wielkosci
mierzonej przez czujnik (ilo§¢ rozpuszczonego tlenu, przewodnos¢ elektryczng lub pH).
Nie mozna kalibrowa¢ drugorzednej, wskazywanej wielkosci czujnika, tj. temperatury.

o Standardowa kalibracja automatyczna

Standardowa kalibracja automatyczna jest dwuetapowa procedura dla czujnikéw pH
i rozpuszczonego tlenu (DO), za$ jednoetapowa - dla czujnikow przewodnosci.

Czujnik Wymagania kalibracji

pH Zastosowa¢ odpowiedni roztwor wzorcowy pH w punkcie
kalibrowania 1.
Zastosowa¢ odpowiedni roztwor wzorcowy pH w punkcie
kalibrowania 2.

Rozpuszczony tlen (DO) | Zastosowac odpowiednig zawartos¢ tlenu (zero tlenu, najczgsciej
atmosfera azotowa) w punkcie kalibrowania 1.

Zastosowac¢ odpowiednia zawartos$c¢ tlenu (otaczajace powietrze)
w punkcie kalibrowania 2.

Przewodnos$¢ Zastosowa¢ odpowiedni, wzorcowy roztwor kalibracyjny
w pojedynczym punkcie kalibrowania.

Tabela 2.1: Wymagania dla kalibracji czujnikow

Czujniki Arc do pomiaru pH i przewodnosci, firmy Hamilton, posiadaja funkcj¢ automatycznego
kalibrowania, dzigki ktorej rozpoznaja wzorzec kalibrowania po zanurzeniu w nim. Oznacza
to, ze mozna wybrac rézne wzorce, od réznych producentow, a mimo to czujnik prawidtowo
wykona swoje automatyczne kalibrowanie.
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Rodzaj czujnika Wzorce do kalibracji
pH

Hamilton

MERCK TITRISOL
DIN 19267

NIST STANDARD
METTLER TOLEDO
RADIOMETR

Rozpuszczony tlen (DO) | Nie jest konieczny zakup wzorca. Patrz: Tabela 2.1.

[ R I R [ R |

Przewodnos¢ o Hamilton
o REAGECON
o Roztwory KCI

Tabela 2.2: Wzorce do kalibracji czujnikéw

Chociaz wzorce od réznych producentéw sg na ogot wystarczajaco podobne, aby czujnik
mogt dokonac ich poprawnej, ogolnej identyfikacji, to roznia si¢ one w istotnych szczegotach
, a szczegoOlnie, gdy chodzi o zaleznos¢ temperaturowa. Z tego powodu, dla uzyskania
optymalnej doktadnosci przy pomiarach pH i przewodnosci, trzeba wprowadzi¢ nazwe
zestawu wzorcow, ktore maja by¢ uzyte. Spis producentdw, ktorych zestawy kalibracyjne
moga by¢ uzywane, jest przechowywany w pamiegci kazdego czujnika i moze si¢ zmienia¢
zaleznie od rodzaju czujnika, modelu oraz wersji.

Uwaga
Wigcej informacji, specyficznych dla danego czujnika, mozna znalez¢ w dokumentacji,
dotaczanej do kupowanych czujnikow Arc.

o Dzialania

1. Wybra¢ czujnik, ktorego ma dotyczy¢ kalibrowanie, na gérnym poziomie ekranowego
interfejsu r¢gcznego monitora.

2. Wprowadzi¢ hasto Administratora, zgodnie z opisem w: ,,Zadanie 1: Nastawianie poziomu
obstugi dla Administratora”, na stronie 45.

3. Przejs¢ do [Sensor] = Tools > Calibration = Calibrate.
Pojawi si¢ ekran, zawierajacy u gory dwa pola dotyczace standardowej kalibracji
automatycznej (dla czujnika przewodnosci, tylko jedno pole), zawierajace odpowiednie
warto$ci wzorcoOw kalibracyjnych, zastosowanych przy ostatnim, zakonczonym
powodzeniem kalibrowaniu. Przyktadowo, dla czujnikéw pH, widaé:
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‘ Calibrate at point 1 4.01 pH ‘
Pola dotyczace standardowe;j
kalibracji automatycznej
‘ Calibrate at point 2 7.00 pH ‘
‘ Product calibration inactive ‘ || Pole kalibracji dla wyrobu
Pole dla standardowej kalibracji automatyczne;j.
Select standard set Hamilton Pojawia sig tylko dla czujnikéw pH i Cond,
a dla DO - nie.

W dolnym polu wida¢ nazwe aktualnie wybranego zestawu wzorcow. W tym przyktadzie,
jest to Hamilton. Od wyboru wzorcow zaleza wartosci, pokazane wyzej, dla punktow 112
kalibracji.

4.

Nalezy sprawdzi¢, czy wybrany jest wlasciwy zestaw wzorcow kalibracyjnych. W razie
potrzeby, mozna klikna¢ OK, aby zmieni¢ wybor.

Spis zestawow kalibracyjnych zalezy od rodzaju uzywanego czujnika i zmienia si¢ dla
réznych czujnikow.

Zastosowac odpowiednie warunki (zawartosc¢ tlenu lub wzorzec) dla czujnika, w punkcie
kalibrowania 1.

Klikna¢ Calibrate at point 1 (kalibruj w punkcie 1).
Odbywa si¢ pierwszy etap kalibrowania.

Zastosowac odpowiednie warunki (zawartos¢ tlenu lub wzorzec) dla czujnika, w punkcie
kalibrowania 2.

Klikna¢ Calibrate at point 2 (kalibruj w punkcie 2).
Nastepuje drugi etap kalibrowania.

W nizej okre§lonym przypadku, kalibrowanie jest anulowane i pojawia si¢ odpowiedni
komunikat ostrzezenia:

m]

Gdy czujnik nie rozpozna wzorca przez ponad 180 sekund, albo gdy wyniki pomiaru sa
niestabilne przez ponad 180 sekund od chwili rozpoczgcia kalibracji.
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Uwaga

Jezeli kalibrowanie nie udato si¢ w jednym punkcie, nie oznacza to, ze czujnik nie
moze by¢ uzywany. W tym przypadku czujnik wykorzystywac bgdzie zapamigtane
dane z ostatniej udanej kalibracji dla wymienionego punktu.

o Roéwnoczesnie, w takim przypadku, wiarygodno$¢ pomiaru zmniejsza si¢. Wiarygodno$é
pomiaru jest wyrazana przez wskaznik jako$ci pomiaru na ekranie 20, tj. [Sensor] >
View = Sensor status. W przypadku niepowodzenia kalibrowania, wyswietlany
jest odpowiedni komunikat ostrzezenia. Wigcej informacji na ten temat podano w punkcie:
»3.4.3 Komunikaty stanu kalibracji”, na stronie 76.

o Kalibrowanie dla wyrobu

Kalibrowanie dla wyrobu przebiega nie przy zanurzeniu czujnika w medium wzorca, ale
w medium wyrobu, podlegajacego aktualnie technologicznej kontroli pomiarowej. Oznacza
to, ze kalibrowanie dla wyrobu odbywa si¢ w instalacji technologicznej, bez konieczno$ci
wymontowania z niej czujnika i jego przenoszenia do laboratorium.

Kalibrowanie dla wyrobu, to procedura, ktora przeprowadza si¢ w uzupetnieniu do
standardowej kalibracji automatycznej. Dostosowuje ona krzywa kalibracji, uzyskana przez
kalibracjg automatyczna do warunkow technologicznych, panujacych w czasie kalibrowania
dla wyrobu (szczegoly techniczne podano w instrukcjach dla programujacych czujnik).
Z powyzszego wyplywa takze wniosek, ze przed wykonaniem kalibrowania dla wyrobu,
nalezy zawsze przeprowadzi¢ standardowa kalibracje¢ automatyczna, aby utworzy¢
optymalnakrzywa kalibracji standardowe;.

Ogolnie ujmujac, procedura kalibrowania dla wyrobu jest nastgpujaca:

1. Wykona¢ pomiar za pomoca czujnika znajdujacego si¢ w instalacji technologicznej,
zanurzonego w mierzonym wyrobie. Przyjmuje sig, ze to jest pomiar poczatkowy.

2. Pobra¢ probke mierzonego wyrobu z instalacji technologiczne;j.

3. W laboratorium wykona¢ pomiar odpowiedniej wielko$ci mierzonej (rozpuszczonego
tlenu, pH lub przewodnosci).

4. Wynik pomiaru laboratoryjnego przekaza¢ do czujnika, aby mdgl on wyliczy¢ przesunigcie
wzgledem standardowej kalibracji automatyczne;.
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Uwaga
o W dowolnej chwili mozna usuna¢ efekt kalibrowania dla wyrobu. Woweczas,
aktywne bedzie podstawowe, standardowe kalibrowanie automatyczne.

o Wynik nowego, standardowego kalibrowania automatycznego, zastepuje (kasuje)
uprzednie kalibrowanie dla wyrobu.

o Dzialania

Uwaga
Jezeli ostatnio tego nie robiono, nalezy wykonac standardowe kalibrowanie automatyczne,
zgodnie z opisem w Standardowa kalibracja automatyczna, na stronie 40.

1. Wybraé czujnik, ktéorego ma dotyczy¢ kalibrowanie, na géornym poziomie ekranowego
interfejsu rgcznego monitora.

2. Wprowadzi¢ hasto Administratora, zgodnie z opisem w: ,,Zadanie 1: Nastawianie poziomu
obstugi dla Administratora”, na stronie 45.

3. Przejs¢ do [Sensor] = Tools = Calibration 2 Calibrate.

Pojawi si¢ ekran, zawierajacy u gory dwa pola dotyczace standardowej kalibracji automatyczne;j
(dla czujnika przewodnosci, tylko jedno pole), zawierajace odpowiednie wartosci wzorcoOw
kalibracyjnych, zastosowanych przy ostatnim, zakonczonym powodzeniem kalibrowaniu.
Przyktadowo, dla czujnikow pH, wida¢:

| Calibrate at point 1 4.01 pH |
Pola dotyczace standardowe;j
kalibracji automatycznej
| Calibrate at point 2 7.00 pH |
| Product calibration inactive | | ‘ Pole kalibracji dla wyrobu
Pole dla standardowej kalibracji automatycznej.
Select standard set Hamilton Pojawia sig tylko dla czujnikéw pH i Cond,

a dla DO - nie.

W dolnym polu wida¢ nazwe aktualnie wybranego zestawu wzorcow. W tym przyktadzie,
jest to Hamilton.
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4. Wybra¢ Product calibration i klikna¢ OK.

Pojawi si¢ ekran ([Sensor] = Tools = Calibration = Calibrate -
Product calibration)podobny do widocznego ponizej:

| Initial measurement inactive |
Lub:

| Initial measurement 35.0° |
| Assigment 20.00%-vol |
| Cancel |

Uwaga
Nalezy zauwazy¢, ze jednostki 1 warto$ci pokazane na ekranie zaleza od rodzaju
wybranego czujnika.

5. Ktorakolwiek z dwu mozliwych wersji ekranu teraz si¢ pojawi, nalezy w mozliwie krotkim
odstgpie czasowym wykonaé ponizsze dwa dzialania:

o Wybra¢ Initial measurement i klikna¢ OK. Spowoduje to zapisanie aktualnego
pomiaru w pamigci czujnika (warto zauwazyé, ze nie bedzie to warto$¢é danej
wielko$ci mierzonej — pH, przewodnosci, czy rozpuszczonego tlenu - zachowana
w pamigci, ale surowa podstawa pomiaru, w oparciu o ktora warto$¢ mierzona jest
dopiero obliczana).

o Pobra¢ probke wyrobu z obiegu technologicznego.

6. Wykona¢ w laboratorium pomiar, na pobranej probee, szukanej wielkosci (rozpuszczonego
tlenu, pH lub przewodnosci).

7. Wybra¢ Assignment i klikna¢ OK. Przekaza¢ warto$¢ laboratoryjna gtéwnej wielkosci
mierzonej (rozpuszczonego tlenu, pH lub przewodnosci - zaleznie od rodzaju czujnika)
do poréwnania z wartoscia Initial measurement.

Teraz odbywa si¢ kalibracja dla wyrobu. Znaczy to, ze warto§¢ gtdéwnej wielkosci mierzone;j,
aktualnie wy$wietlanej na r¢cznym monitorze dla wybranego czujnika, jest wlasnie regu-
lowana w celu uzyskania wigkszej doktadnosci w warunkach technologicznych, w ktorych
czujnik byt kalibrowany.
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2.4 Zadania Specjalisty

Jak juz powiedziano, system Arc firmy Hamilton wyrdznia trzy stopnie uprawnien
obstugujacego: Uzytkownik, Administrator i Specjalista. Sposrod nich Specjalista ma
najwyzszy zakres dostgpu. (Szerszy opis tego tematu mozna znalezé w punkcie:
»1.5.2 Czujniki Arc: poziomy obslugujacego”, na stronie 20.)

Oprocz swoich wlasnych zadan, Specjalista moze wykonywac:
o Wszystkie zadania Uzytkownika;
o Wszystkie zadania Administratora.

Uwaga

Przed zapoznawaniem sig¢ z dalsza trescia tego punktu, nalezy koniecznie, dobrze
poznaé zadania Uzytkownika i Administratora (patrz punkt: ,,2.2 Zadania Uzytkownika”,
na stronie 40 i punkt: ,,2.3 Zadania Administratora”, na stronic 44).

Zadanie 1: Nastawianie poziomu obshugi dla Specjalisty
o Wstep

Aby wykonywa¢ zadania Specjalisty, obstugujacy musi najpierw wprowadzi¢ hasto Specjalisty.
Objasniono to bezposrednio, ponize;j.

o Dzialania

W razie potrzeby, wlaczy¢ reczny monitor naciskajac roéwnoczesnie przyciski ,lewy”
i,,prawy” przez 3 sekundy.

1. Jezeli reczny monitor jest juz wlaczony, nalezy naciskaé przycisk ,,lewy” az do osiagnigcia
gornego poziomu ekranowego interfejsu, gdzie widoczne sa pola przegladania danych

(Rysunek 1.2: Reczny monitor Arc View z widocznym, gornym poziomem ekranowego
interfejsu; przylaczony czujnik pH, na stronie 10).

2. Wybra¢ czujnik, ktorego maja dotyczy¢ przewidziane dzialania.
3. Klikna¢ Tools.
4. Wybra¢ S w przypadku Specjalisty.

5. Klikna¢ OK i wprowadzi¢ nastepujace hasto: 16021966
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Uwagi
A o Wyzej wskazane hasto jest fabrycznym hastem domyslnym dla Specjalisty.
Mozna je zmieni¢ przy uzyciu bezptatnego oprogramowania Arc Sensor
Configurator.

o Zawsze, gdy reczny monitor wylacza si¢ automatycznie lub zostaje
wylaczony recznie, albo, gdy obstugujacy wraca do gérnego poziomu ekrano-
wego interfejsu, czujnik domyslnie wraca do trybu obstugi przez Uzytkownika.
Jednakze, jezeli przy powrocie do gornego poziomu ekranowego interfejsu,
obshugujacy wyraznie potwierdzi, ze chce on, lub ona, zachowaé hasto, przy
uzyciu ktorego wszedl, to rgczny monitor zapamigta hasto. W takim wypadku,
gdy uzytkownik kliknie Tools, aby uzyskaé¢ dostep do funkcji chronionych
hastem, musi on, lub ona, tylko potwierdzi¢ hasto (bez ponownego wprowadzania).

Zadanie 2: Zarzadzanie nastawieniami monitora recznego
o Wstep

Zmiana nastawien monitora rgcznego nie jest zwyczajnym zadaniem. Sposrod przedstawionych tu
nastawien, konieczne jest tylko nastawienie daty i czasu, a i to, jedynie dla nowego monitora
recznego lub w przypadku przesunig¢ po dlugim czasie, albo po wymianie akumulatora na
nowy.

Niniejsze zadanie sktada si¢ nastgpujacych podzadan:
o Podzadanie 2.1: Wykonanie nastawien daty i czasu (konieczne okazjonalnie),

o Podzadanie 2.2: Nastawienia konfiguracji ekranu i zasilania monitora r¢cznego
(opcja),

o Podzadanie 2.3: Nastawienia konfiguracji monitora recznego do pracy bezprzewodowej
(opcja).
Podzadanie 2.1: Wykonanie nastawien daty i czasu

o Wstep

Monitor rgczny Arc wyswietla biezacy czas w gornym, lewym rogu ekranu (Rysunek 1.2,
na stronie 10). Chociaz monitor nie pokazuje aktualnej daty, to data jest uzywana przy
tworzeniu przez system Arc plikow STA (Zadanie 4: Zarzadzanie profilami STAnu czujnika”,
na stronie 60).
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o Dzialania

1. Wybra¢ pole Arc View Handheld na gornym poziomie ekranowego interfejsu r¢gcznego
monitora (jest ono pokazane na Rysunku 1.2, na stronie 10).

2. Kliknaé Tools.

3. Wprowadzi¢ hasto Specjalisty, zgodnie z opisem kroku 5 w: ,,Zadaniu 1: Nastawianie
poziomu obslugi dla Administratora”, na stronie 45.

4. Wybra¢ Settings ikliknaé OK.

5. Wybra¢ Set time ikliknaé OK.
Nastawi¢ aktualny czas.

6. Wybra¢ Set date iklikna¢ OK.
Nastawic¢ aktualna date.

Uwaga
A Czas jest wySwietlany w formacie 24-godzinnym. Data jest wys$wietlana jako
DD-MM-YYYY. Tych formatow wyswietlania nie mozna zmienic.

Podzadanie 2.2: Nastawienia konfiguracji ekranu i zasilania monitora recznego
o Wstep

Domyslnie, monitor reczny Arc wytacza ekran po 5 minutach braku aktywnosci (tj. po 5 minutach,
w czasie ktorych nie odbyly si¢ na monitorze zadne manipulacje). Naci$nigcie dowolnego
przycisku powoduje ponowne wlaczenie ekranu.

Podobnie, domyslnie, monitor rgczny Arc sam wylacza si¢ catkowicie po 20 minutach
bezczynnosci. Mozna go wtedy wlaczy¢ w zwykty sposob, naciskajac rownoczesnie przyciski
LHlewy” 1, prawy” przez 3 sekundy.

Dla automatycznego wylaczania zarowno ekranu, jak i samego monitora r¢gcznego, mozna
konfigurowac czas wylaczania, nastawiajac go w zakresie od 1 minuty do nieskonczonosci
(bez wylaczania) w sposob nizej opisany.

Uwaga
Wylaczenie ekranu nie oznacza wylaczenia rgcznego monitora, ani wstrzymania
monitoringu czujnikéw. Polega ono na samym wyltaczeniu wyswietlacza.

W odniesieniu zar6wno do nastawienia wylaczania ekranu, jak i monitora,
automatyczne wylaczanie odbywa sig niezaleznie od tego, czy przyrzad znajduje
si¢ w stacji dokowania (Dock).
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o Dzialania

1. Wybraé pole Arc View Handheld na géornym poziomie ekranowego interfejsu recznego
monitora (jest ono pokazane na Rysunku 1.2, na stronie 10).

2. Kliknaé Tools.

3. Wprowadzi¢ hasto Specjalisty, zgodnie z opisem kroku 5 w: ,,Zadanie 1: Nastawianie
poziomu obslugi dla Administratora”, na stronie 45.

4. Wybra¢ Settings i klikna¢ OK.

5. Wybra¢ Display settings 1 klikna¢ OK.
Nastawi¢ okres czasu, przez jaki ekran ma pozostawaé wiaczony. Sa tu dwie mozliwosci:

o Wprowadzi¢ czas w minutach.

o Wprowadzi¢ 000, aby ekran nigdy nie wytaczat si¢ automatycznie.
6. Wybrac¢ Power setting i klikna¢ OK.

7. Nastawi¢ czas dla automatycznego wylaczania przyrzadu, tak jak dla wytaczania wyswietlacza.

Podzadanie 2.3: Nastawienia konfiguracji monitora recznego do pracy bezprzewodowej
o Wstep

Nastawienia komunikacji bezprzewodowej rgcznego monitora Arc reguluja tacznosé
miedzy adapterami czujnikowymi Arc Wi, mocowanymi do czujnikéw i modutem Arc RF
umieszczonym w r¢cznym monitorze.

Nastawienie komunikacji bezprzewodowej recznego monitora Arc moze mie¢ dwie
konfiguracje: Auto, albo Always ON.

Auto jest konfiguracja domyslna: r¢czny monitor komunikuje si¢ przewodowo, tylko,
gdy jest umieszczony w stacji dokowania (Dock), a przetacza si¢ automatycznie na
komunikacj¢ bezprzewodowa, gdy pracuje poza stacja.

Alternatywna konfiguracja jest Always ON: komunikacja bezprzewodowa jest stale wlaczona,
czy monitor jest umieszczony w stacji dokowania, czy tez nie. Dzigki temu, mozliwa jest
stata, bezprzewodowa komunikacja nawet z 30 czujnikami, zamiast przewodowej tacznosci
z pojedynczym czujnikiem. Ponadto, gdy r¢czny monitor znajduje si¢ w stacji dokowania,
jego akumulator taduje sig.
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Komunikacja przewodowa nie jest mozliwa przy nastawieniu Always ON, to znaczy,
ze czujnik potaczony przewodowo nie jest wtedy widziany przez r¢czny monitor, ktory
umieszczony jest w stacji dokowania (Dock).

Po wytaczeniu r¢cznego monitora, resetuje si¢ on zawsze do domyslnego nastawienia Auto.
Aby nastawi¢ Always ON, nalezy postgpowac zgodnie z instrukcjami podanymi w ,,Dzialania”,
bezposrednio ponizej.

o Dzialania

1. Wybraé pole Arc View Handheld na gornym poziomie ekranowego interfejsu recznego
monitora (jest ono pokazane na Rysunku 1.2, na stronie 10).

2. Kliknaé Tools.

3. Wprowadzi¢ hasto Specjalisty, zgodnie z opisem kroku 5 w: ,,Zadanie 1: Nastawianie
poziomu obslugi dla Administratora”, na stronie 45.

4. Wybra¢ Settings i klikna¢ OK.
5. Wybra¢ Wireless settings i klikna¢ OK.

6. Wybra¢ Auto lub Always ON.

Zadanie 3: Nastawianie nowego czujnika w systemie Arc

Praca Specjalisty obejmuje nastawianie i konfigurowanie elementow systemu Arc. Najczgstszym
zadaniem jest dodawanie lub wymiana czujnika. To zadanie wygodnie jest podzieli¢ na
nastepujace podzadania:

o Podzadanie 3.1: Wprowadzanie ID czujnika,

o Podzadanie 3.2: Konfigurowanie adresu Modbus urzadzenia,
o Podzadanie 3.3: Konfigurowanie szybkosci transmisji,

o Podzadanie 3.4: Konfigurowanie interfejsu analogowego,

o Podzadanie 3.5: Konfigurowanie kalibrowania.
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Podzadanie 3.1: Wprowadzanie ID czujnika

Uwaga
A o To Podzadanie jest polecane, gdy trzeba doda¢ czujnik Arc do systemu Arc.

o To Podzadanie dotyczy tylko interfejsu cyfrowego czujnika.

Kazdy czujnik w systemie Arc posiada kilka identyfikatoréw. Naleza do nich:

o Nazwa wyrobu, np. VISIFERM DO Arc.

o Wersja oprogramowania sprz¢towego z kodem zapisanym w czujniku.
o Numer czujnika jako czgsci.

o Numer seryjny czujnika.

o Adres czujnika jako urzadzenia Modbus.

Kazdy obstugujacy moze sprawdzic¢ te identyfikatory przez menu [Sensor] = View =
Sensor info.

Wigkszos$¢ tych identyfikatorow jest nastawiana w fabryce producenta i nie moze by¢ zmieniona.
Specjalista jednak, moze zmienia¢ ID czujnika. Domyslnie, jest to tancuch zawierajacy numer
czujnika jako czg$ci, a nastepnie numer seryjny czujnika. Czgsto, pomocne jest wprowadze-
nie tancucha, ktory jednoznacznie identyfikuje czujnik w srodowisku konkretnego systemu
Arc. Przyktadowo, tancuch Process C3 moze umozliwi¢ innym obstugujacym szybka
identyfikacj¢ czujnika w jego §rodowisku technologicznym.

Uwaga
ID czujnika jest zapisany w pamigci czujnika. Zawsze, gdy wymienia si¢ czujnik
na nowy, nalezy sprawdzi¢ tancuch ID w nowym czujniku.

Specjalista moze zmieni¢ ID czujnika korzystajac zmenu [Sensor] = View = Sensor
info.
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Podzadanie 3.2: Konfigurowanie adresu Modbus urzadzenia

Uwaga
A o To podzadanie jest wazne, gdy trzeba doda¢ czujnik Arc do cyfrowego systemu PLC.

o To podzadanie dotyczy tylko cyfrowego interfejsu czujnika.

Adres urzadzenia Modbus czujnika Arc jednoznacznie identyfikuje dany czujnik Arc
w grupie czujnikow Arc dla celow komunikacji cyfrowej w systemie PLC (nie ma on jednak
znaczenia w komunikacji z rgcznym monitorem Arc View, ani w potaczeniu z interfejsem
analogowym 4+20 mA).

Zaleca sig, aby kazdy czujnik w systemie Arc mial swoj adres urzadzenia Modbus. Wigcej
o adresach urzadzen Modbus mozna przeczyta¢ w punkcie: ,,1.5.5.2 Adresy urzadzen
Modbus”, na stronie 23.

Specjalista moze zmieni¢ adres urzadzenia Modbus czujnika, korzystajac z menu [Sensor] =
Tools 2 Interface configuration > Digital RS485.

Podzadanie 3.3: Konfigurowanie szybko$ci transmisji

Uwaga
A o To podzadanie jest wazne, gdy trzeba doda¢ czujnik Arc do cyfrowego systemu PLC.

o To podzadanie dotyczy tylko cyfrowego interfejsu czujnika.

Szybkos¢ transmisji wplywa na dziatanie przewodowego potaczenia czujnikéw Arc
z cyfrowym interfejsem RS485 Modbus. Nie ma ona znaczenia dla bezprzewodowego, ani
dla analogowego potaczenia czujnika.

Wigcej o szybkosci transmisji mozna przeczyta¢ w punkcie: ,,1.5.5.3 Szybko$¢ transmisji”,
na stronie 27.

Informacje o nastawianiu szybkosci transmisji dla czujnika znajduja si¢ tezw menu [Sensor] =
Tools =2 Interface configuration = Digital RS485.
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Podzadanie 3.4: Konfigurowanie interfejsu analogowego

Uwaga
A o To podzadanie jest niezbedne, gdy czujnik jest przytaczony do analogowego
systemu PLC.

o To podzadanie dotyczy tylko analogowego interfejsu (lub obu takich uktadow
interfejsu) czujnika.

Przez konfiguracje analogowego interfejsu czujnika Arc, umozliwia si¢ przenoszenie
wartos$ci mierzonej do standardowego interfejsu 4+20 mA. Konfigurowanie opcji analo-
gowego interfejsu jest zagadnieniem szerokim, ktdre szczegdtowo objasniono w punkcie:
»1.5.6.3 Konfigurowanie trybu interfejsu analogowego”.

Uwaga
Jezeli polaczenie analogowe nie jest wykorzystywane, zaleca si¢ wylaczenie interfejsu
analogowego.

Specjalista moze skonfigurowac interfejs analogowy czujnika przez menu [Sensor] =
Tools 2 Interface configuration 2?mA interface #1 [lub #2, lub
mA / ECS-Interface].

Podzadanie 3.5: Konfigurowanie kalibrowania

System Arc uzywa standardowej kalibracji automatycznej (punkt: ,,1.5.4 Czujniki Arc: dwa
rodzaje kalibrowania), w czasie ktorej kazdy czujnik Arc:

1. Wykonuje odczyt pomiarowy (pH, przewodnosci, rozpuszczonego tlenu) dla wzorca,
w ktorym zostat umieszczony.

2. Przeprowadza prosta procedurg rozpoznania, polegajaca na poréwnaniu odczytu pomiarowego
z kazdym wzorcem wybranego zestawu wzorcow kalibracyjnych (domyslnie - firmy
Hamilton). Wynikiem jest doktadna identyfikacja wzorca, w ktérym czujnik zostat
umieszczony.

3. Automatycznie dopasowuje odczyt pomiarowy tak, aby jak najlepiej zgadzat si¢ ze znana
warto$cia rozpoznanego wzorca.

W przypadku standardowej kalibracji automatycznej Arc, wszystkie potrzebne dane kalibracyjne
(np. warto$ci zalezne od temperatury), dotyczace calego wachlarza wzorcow, rdéznych
producentoéw, sa kodowane w kazdym czujniku Arc podczas jego produkcji. Oznacza to,
ze nie ma potrzeby, aby obstugujacy recznie konfigurowat jakiekolwiek detale dla standardowe;j
kalibracji automatyczne;.
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Tym niemniej, system Arc oferuje nastgpujace opcje konfigurowania kalibracji:

o Specjalista moze wybra¢ zestaw wzorcow, sposrod ktorych czujnik Arc zidentyfikuje
wzorzec, w ktorym zostal umieszczony. W tym celu korzysta on z menu Sensor] =
Tools 2 Calibration - Calibrate.

(Zestaw wzorcodw kalibracyjnych firmy Hamilton jest fabrycznie, domys$lnie nastawiany
dla wszystkich czujnikow Arc. Specjalista moze jednak wybra¢ dowolny zestaw,
zakodowany w czujniku.)

o Przyuzyciudarmowego oprogramowaniaArc sensor Configurator, obstugujacy moze
przegladac i na nowo zdefiniowa¢ wzorce zawarte w zestawach wzorcow, zakodowanych
w czujnikach Arc.

Zadanie 4: Zarzadzanie profilami STAnu czujnika

Uwaga
To zadanie normalnie jest potrzebne tylko przy wykrywaniu i usuwaniu usterek
oraz zarzadzaniu jako$cia.

o Wstep

Profil STAnu czujnika (STA) stanowi spis wszystkich informacji o czujniku. Oczywiscie,
zawartos$¢ takiego profilu zalezy od rodzaju czujnika. Dla wszystkich czujnikéw natomiast,
znajdujq si¢ tam trzy kategorie informacji:

o Informacje trwale (numer seryjny, informacja o wyrobie).

o Informacje tymczasowe (wersja oprogramowania sprzgtowego, konfiguracja interfejsu,
nastawienia pomiarowe).

o Informacja ,,migawkowa” o stanie czujnika w chwili utworzenia profilu (btad, ostrzezenice).

Profile STAnu czujnika moga by¢ uzyteczne dla zarzadzania jakoscia oraz do wykrywania
i usuwania usterek z pomoca pracownikow obstugi technicznej firmy Hamilton.

Podzadanie 4.1: Tworzenie pliku profilu STAnu czujnika
o Wstep

Plik profilu STAnu czujnika (STA) tworzy sig przez kopiowanie informacji z czujnika do
recznego monitora. Powstaje w ten sposob plik przechowywany w pamigci recznego monitora.
Aby to wykona¢, czujnik, z ktorego chce si¢ skopiowa¢ dane musi by¢ potaczony z monitorem
recznym za pomocg przewodu lub w sposob bezprzewodowy.
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W pamigci monitora recznego przewidziano miejsce na 16 plikow STA. Jezeli utworzony
zostanie siedemnasty taki plik, to plik pierwszy zostanie automatycznie usunigty (mozna
to nazwac stosem plikodw, zbudowanym na zasadzie ,,pierwszy na wejsciu - pierwszy na

wyjsciu”).

Nazwa pliku: STAxxxxx.txt, gdzie xxxxx jest kolejnym numerem, shuzacym do identyfikacji
pliku.

Typowa wielkos$¢ plikow STA wynosi 30 do 50 kB.

o Dzialania

1. Wybra¢ czujnik, dla ktéorego ma by¢ utworzony plik STA, na géornym poziomie
ekranowego interfejsu rgcznego monitora, pokazanym na: ,,Rysunku 1.2: Reczny monitor
Arc View zwidocznym, gérnym poziomem ekranowego interfejsu; przylaczony czujnik pH”,
na stronie 10).

2. Wejs¢ na poziom obstugujacego - Specjalisty, zgodnie z opisem w: ,,Zadanie 1: Nastawianie
poziomu obshugi dla Specjalisty”, na stronie 52.

3. Przejs¢ wmenu do [Sensor] = Tools - Data management.

4. Wybra¢ Data transfer (Sensor to Arc View)iklikna¢ OK.
Otworzy sig przejsciowy ekran z wybranym Sensor status profile.

5. Klikna¢ OK.
W pamigci rgcznego monitora tworzy sig plik STA. Na ekranie informacyjnym pokazywany
jest postep tego procesu.

Podzadanie 4.2: Pobieranie pliku profilu STAnu czujnika
o Wstep

Przyjmuje si¢, ze w pamigci recznego monitora znajduje si¢ jeden lub wigcej plikow (STA)
profilu STAnu czujnika. Nalezy skopiowac przynajmniej jeden z nich do pendrive’a (pamigci USB)
w porcie USB.

61



INTROL Sp. z o.0., ul. Ko$ciuszki 112, 40-519 Katowice, tel.: 32/78 90 067, faks: 32/78 90 010, e-mail: fizchem@introl.pl, www.introl.pl

o Dzialania

1. Upewnic¢ sig, ze reczny monitor znajduje si¢ w stacji dokowania, a pendrive jest wtozony
do gniazda w stacji Dock.

2. Przej$¢ w menu do Arc View Handheld - Tools - Data management >
Data transfer (Arc View to USB device).
Pojawi sig ekran posredni z wybrana opcja Sensor status profile.

3. Klikna¢ OK.
Pojawia si¢ drugi ekran posredni z lista dostepnych plikow STA.

4. Nalezy wybrac plik, ktéry ma by¢ pobrany do pendrive’a, wlozonego do portu USB stacji
dokowania, a nastgpnie klikna¢ OK.

5. Otwiera si¢ koncowy ekran posredni z krotkim przegladem wybranego pliku. Teraz trzeba
klikna¢ OK, aby pobra¢ plik do pendrive’a, albo - w przypadku mylnego wyboru - klikna¢
przycisk ,,lewy” by wroci¢ do spisu i dokona¢ nowego wyboru.

Podzadanie 4.3: Odczytywanie pliku profilu STAnu czujnika

Odczytywanie pliku profilu STAnu czujnika (STA) jest proste: mozna go przeglada¢ lub
wydrukowa¢ przez kazdy program, ktoéry umozliwia wyswietlanie tekstu ASCII (doskonaty
jest Excel, ale Notepad lub MS Word tez sa dobre do tego celu).

Zadanie 5: Zarzadzanie plikami obserwacyjnymi
Podzadanie 5.1: Tworzenie plikow obserwacyjnych

Przy uzyciu recznego monitora Arc View mozna rejestrowaé dane pomiarowe jednego
czujnika w postaci pliku obserwacyjnego (trace file).

Zawsze, gdy przegladany jest ekran Graph/data log z poziomu Specjalisty ([Sensor] =2
Tools & Measurement 2 Graph / data log), tworzony jest plik obserwacyjny.
Nazwa pliku jest wyswietlana w tytule, pod nazwa DATxxxxx.txt (gdzie xxxxx jest kolejnym
numerem). Przy zamykaniu ekranu Graph/data log, rejestracja danych jest zatrzymywana.
Ponowny powrdt do omawianego ekranu powoduje utworzenie nowego pliku obserwacyjnego.

Jezeli komunikacja z czujnikiem zostanie przerwana, punkty danych na wykresie,
odpowiadajace ostatnim waznym wynikom pomiardéw, sa wyswietlane na czerwono. W pliku
obserwacyjnym rejestrowane beda wtedy tylko znaczniki czasu dla warto$ci mierzonych,
bez wynikow z czujnika.
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Uwaga
Gdy dziata rejestrowanie danych, r¢gczny monitor nie wytacza si¢ automatycznie.
Tylko wyswietlacz jest wygaszany przy braku aktywnosci.

Uwaga

Gdy pamig¢ recznego monitora zostanie zapehiona, to najstarsze pliki sa zastgpowane
(nadpisywane) przez nowe. Reczny monitor Arc View moze przechowywacé
w pamigci najwyzej 16 plikow kazdego rodzaju. Maksymalna wielko$¢ pojedynczego
pliku, to 256 kB, co odpowiada 8.3 godziny rejestrowania danych pomiarowych.

Podzadanie 5.2: Pobieranie plikéw obserwacyjnych

1.

Umiesci¢ reczny monitor w stacji dokowania Dock, a pendrive (pamig¢ USB) wlozy¢
do gniazda USB w stacji Dock.

Wiaczy¢ reezny monitor, jezeli nie jest wlaczony. Przejs¢ w menu do Arc View
Handheld - Tools = Data management = Data transfer (Arc View
to USB device).Wybra¢ Graph/data log. Pojawi sig ekran z lista dostgpnych plikow
obserwacyjnych.

Wybra¢ zadany plik i klikna¢ OK. Widoczny stanie si¢ ekran z informacjami na temat
wybranego pliku. Ponownie klikna¢ OK. Wtedy wybrany plik zostanie pobrany do
pendrive’a.

Podtaczy¢ pendrive do komputera.

W komputerze mozna otworzy¢ wskazany plik, w programie edytora tekstu lub edytora
tabel.

Podzadanie 5.3: Interpretacja pliku obserwacyjnego

Charakterystyka pliku obserwacyjnego:

m]

Nazwa pliku: DATxxxxx.txt, gdzie xxxxx jest kolejnym numerem, shuzacym do identyfikacji
pliku.

Uwaga
Jezeli w komputerze znajduja si¢ pliki utworzone w kilku ré6znych monitorach
rgcznych, to kilka z nich moze mie¢ taka sama nazwg.

Wiasciwosci pliku: plik tekstowy w standardowym kodzie ASCII, bloki tekstu
oddzielone znakami tabulacji.
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Przykladowy plik obserwacyjny

*** Measurement data log file ***

Filename: DATO00001
Arc VIEW H

Part number

Serial number

RF address
Firmware version
Date Time

Arc Wi sensor adapter
Part number

Serial number

RF address

Firmware version

Sensor info

Firmware version user
end

Firmware date user end
Productname

Part number

Workorder number
Workorder date

Serial number

Sensor ID

Date Time

2010-11-31 14:24:05
2010-11-31 14:24:09
2010-11-31 14:24:13
2010-11-31 14:24:17
2010-11-31 14:24:21
2010-11-31 14:24:25
2010-11-31 14:24:29
2010-11-31 14:24:33
2010-11-31 14:24:37
2010-11-31 14:24:41
2010-11-31 14:24:45

Tabela 2.3: Przyklad pliku obserwacyjnego: tekst ASCII importowany do programu edycji tekstu
i przeksztalcony w tabele. W tytule zawiera on nazwe pliku, w nagléwku - informacje

242128/03

000100

59568134
VIHMS024
2010-11-31 14:24

242170/00

0327646

59560146

WIOMSO006

EPHUMO11

2010-04-23

Polilyte Plus

242111/00

1388539

2010-02-22

1201

EPHO2

pH / pH T/ °C
6.191 26.410
6.191 26.410
6.191 26.410
6.191 26.410
6.191 26.410
6.191 26.411
6.191 26.411
6.191 26.411
6.191 26.410
6.191 26.411
6.191 26.411

o czujniku, a dane pomiarowe ze znacznikami czasu - w gléwnej tresci
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Zadanie 6: Zarzadzanie plikami konfiguracji czujnika
o Wstep

Plik konfiguracji czujnika jest zestawem kolejnych skryptéw polecen czujnika, uzywanym
przez rgezny monitor Arc View do konfigurowania czujnikow. Pliki te mozna tworzy¢ r¢cznie
w komputerze, kopiowac¢ do monitora r¢gcznego, a z niego do konkretnego czujnika. Mozna
tez wygenerowac¢ taki plik bezposrednio w oparciu o konfiguracj¢ innego, dziatajacego
czujnika.

Uwaga

A Pliki konfiguracji czujnika sa mocnym narzedziem. Ich btgdne uzycie moze prowadzi¢
do nieprawidtowej konfiguracji czujnika i niewtasciwego dziatania w aplikacji.
Nalezy doktadnie sprawdzi¢ nowo skonfigurowane czujniki przed uzyciem ich
w konkretnym zastosowaniu! Jezeli nie dziataja one zgodnie z przewidywaniami,
trzeba przejrze¢ i rgcznie skorygowac cata konfiguracje czujnika.

Uwaga
Nazwa pliku konfiguracji czujnika musi mie¢ rozszerzenie .pro i musi sktadac si¢
doktadnie z o$miu (8) cyfr i liter, nie liczac rozszerzenia.

Podzadanie 6.1: Tworzenie pliku konfiguracji czujnika z dzialajacego czujnika

1. Wejs¢domenu [Sensor] > Tools = Data management = Data transfer
(Sensor to Arc View) = Sensor configuration ikliknaé OK.

2. Reczny monitor Arc View wygeneruje i zapisze plik konfiguracji czujnika w swej
wewngtrznej pamigci.

3. Aby przenies¢ plik konfiguracji czujnika do komputera, nalezy otworzy¢ menu
Arc View Handheld 2 Tools = Data management = Data transfer
(Arc View to USB device). Nastgpnie wybraé Sensor configuration
1 klikna¢ OK. Zaznaczy¢ jeden plik z listy i klikna¢ OK, aby pobra¢ ten plik do pamigci
pendrive’a.

Uwaga

Przy tworzeniu pliku konfiguracji czujnika w oparciu o konfiguracj¢ innego,
dziatajacego czujnika, adres urzadzenia, szybkos$¢ transmisji i hasta nie sa
przenoszone.
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Podzadanie 6.2: Re¢czne tworzenie pliku konfiguracji czujnika przy uzyciu komputera

Uwaga

Do tworzenia plikéw konfiguracji czujnika mozna przystapi¢ tylko po dobrym
zaznajomieniu si¢ ze sktadnig. Informacje o funkcjonowaniu czujnika i strukturze
polecen mozna znalez¢ w Instrukcjach Programowania Arc dla odpowiednich
czujnikow Arc.

Utworzy¢ plik konfiguracji czujnika w edytorze tekstu, jako plik z nie szyfrowanym tekstem
ASCII. Nazwa pliku konfiguracji czujnika musi mie¢ rozszerzenie .pro i musi sktadac sig
doktadnie z o$miu (8) cyfr i liter, nie liczac rozszerzenia.

Struktura pliku konfiguracji czujnika:

o Zasady ogdélne:

o Pola danych musza by¢ oddzielone znakiem $rednika;
o Naglowek musi spetnia¢ zasady zgodnos$ci

o Sekcja polecen musi zawieraé polecenia odpowiednie dla czujnika

o Naglowek:

o Musi zawieraé lini¢ okreslajaca numery czgsci firmy Hamilton dla czujnikéw, do
ktorych plik konfiguracjisi¢ odnosi. Musi onarozpoczynac si¢ od stowa kluczowego PART.
Przyklad: PART;242450-01; 242452-02; 242453-01

o Moze zawiera¢ linig okreslajacq wersje oprogramowania sprzgtowego, ktorych plik
konfiguracji dotyczy. Musi ona rozpoczynac si¢ od stowa kluczowego FIRMWARE.
Przykltad: FIRMWARE; ODOUMO038; ODOUMO037

o Moze zawiera¢ linig okreslajaca ID czujnikow, ktorych plik konfiguracji dotyczy. Musi
ona rozpoczynac si¢ od stowa kluczowego SENSOR.
Przyklad: SENSOR; DO123; DO124, DO125

o Moze zawiera¢ linig okreslajaca poziom obstugujacego, ktory ma prawo przestac plik
konfiguracji do czujnika. Musi ona rozpoczynac si¢ od stowa kluczowego OPERATOR.
Przyklad: OPERATOR; S. W tym przypadku, plik konfiguracji moze by¢ przestany
do czujnika wylacznie przez obstugujacego z poziomu Specjalisty.

Tg linig stosuje si¢ tylko, gdy plik zawiera polecenia normalnie zarezerwowane dla
obstugujacego z poziomu D.
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o Sekcja polecen sklada si¢ z linii polecen, ktére w kolejnosci obejmuja:

m}

m]

Stowo kluczowe REGISTER, obowiazkowo,
Adres rejestru Modbus, obowiazkowo,
Tlo$¢ zdefiniowanych rejestrow, obowiazkowo,

Typ(y) danych zdefiniowanych rejestrow, oddzielone odst¢pami, obowiazkowo (patrz
ponizej Tabela 2.4 z typami danych),

Wartosci zdefiniowanych rejestrow, oddzielone odstgpami, obowiazkowo,

Komentarze, opcjonalnie.

Typ danych Symbol

Liczby catkowite bez znaku (32 bit)

Liczby zmiennoprzecinkowe (32 bit)

Liczby uktadu heksagonalnego (Hex) (32 bit)

Znaki tekstowe

===

Tabela 2.4: Zdefiniowane typy danych

Uwaga

Mozna wykorzysta¢ wszystkie funkcje opisane w Instrukcjach Programowania
Arc do zaprogramowania pliku konfiguracji czujnika. W danym czujniku zostang
zmienione tylko parametry zawarte w pliku. Reszta konfiguracji czujnika pozostaje
bez zmian.

Uwaga
A Tylko Specjalista moze przesyta¢ pliki konfiguracji do czujnikow.
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o Przyklad pliku konfiguracji czujnika

Trzy linie nagtowka decyduja, ze ta konfiguracja dotyczy wytacznie czujnika VISIFERM DO 120
(PN 242450-01) z wersja oprogramowania ODOUMO038 i z ID czujnika DO1. Nastepne linie
ustalaja jednostke i konfiguracj¢ 420 mA dla gtownej wielkosci mierzone;j.

PART; 242450-01

FIRMWARE; ODOUM038

SENSOR; DO1

REGISTER; 2090; 2; H; 0x10; Measurement unit is %-vol
REGISTER; 4364; 2; H; 0Oxl; readout of the primary measurement
parameter via the 4+20 mA interface

REGISTER; 4360; 2; H; 0x2; linear configuration 4+20 mA linear
REGISTER; 4378; 6; F F F; 0 62.85 0;Konfiguration 4+20 mA
(min, max, mid wvalue)

Podzadanie 6.3: Przekazywanie pliku konfiguracji do czujnika
Przekazywanie pliku konfiguracji czujnika z pendrive’a do r¢cznego monitora Arc View:

1. Umiesci¢ reczny monitor w stacji dokowania Dock 1 wlozy¢ do gniazda USB stacji Dock
pendrive, zawierajacy plik konfiguracji czujnika.

2. Wej$¢ do Arc View Handheld = Tools = Data management = Data
transfer (Arc device to Arc View).

3. Zaznaczy¢ jeden plik konfiguracji czujnika z listy i klikna¢ OK.
4. Pokazywana bedzie informacja o przebiegu transferu danych.

Przekazywanie pliku konfiguracji czujnika z recznego monitora do czujnika:

1. Wejs¢ do [Sensor] = Tools - Data management = Data transfer
(Arc View to sensor) = Configuration Profile iklikna¢ OK.

2. Zaznaczy¢ wlasciwy plik konfiguracji czujnika i klikna¢ OK.

3. Parametry zdefiniowane w pliku konfiguracji czujnika zostang przeniesione do czujnika.
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Zadanie 7: Nastawianie ostrzezen i sygnalizacji USP<645> przy uzyciu
CONDUCELL PWSE Arc

Objasnienia dotyczace USP<645> oraz znaczen ,,0strzezenia USP” i ,,sygnalizacja USP”
znajduja si¢ w Instrukcji CONDUCELL PWSE Arec.

Podzadanie 7.1: Konfigurowanie wyjs$¢ cyfrowych 1/0 dla ostrzezenia lub sygnalizacji

1. Wejs¢ w menu do [Sensor] = Tools = Interface configuration =
Digital I/O #1 [lub #2] [l Interface mode. (,,Digital I/O” oznacza
aktualne wyjscie, ktoére moze mie¢ dwa stany: ,,on” lub ,,0ff”).

2. Wybra¢ albo OFF, USP warning, albo USP alarm.

Mozna wybra¢ Inverted output (wyjscie odwrocone), gdy wyjscie cyfrowe powinno
przybieraé¢ gorny lub dolny stan w wypadku pojawienia si¢ ostrzezenia lub sygnalizacji.

Podzadanie 7.2: Definiowanie czulo$ci dla ostrzezenia lub sygnalizacji USP

1. Wejs¢ w menu do [Sensor] = Tools = Interface configuration =
Digital I/Omin span.

2. Okresli¢ liczbe punktow pomiarowych, dla ktérych musi wystapié¢ przekroczenie, przed
wystaniem ostrzezenia lub sygnalizacji.

Podzadanie 7.3: Definiowanie poziomu ostrzegania
1. Wej$¢ wmenudo [Sensor] = Tools > Measurement > USP function.

2. Wybraé wartos¢ od 0 (warto$§¢ minimalna) do 100 (warto$¢ maksymalna), aby okresli¢
dlajakiego % granicy sygnalizacji ma pojawiac sig¢ ostrzezenie. 0 0znacza brak ostrzezenia
i sygnalizacji alarmowej, a 100 — tylko sygnalizacjg.

Uwaga
Szczegodty dotyczace ostrzezen i sygnalizacji USP podano w rozdziale: ,,Interfejs
dla sygnaléw zgodnych z USP <645>”, instrukcji: ,, CONDUCELL PWSE Arc’.
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Zadanie 8: Polaryzacja czujnika OXYFERM FDA Arc lub OXYGOLD Arc

Dla uzyskania stabilnych wynikow pomiaréw, czujnik OXYFERM FDA Arc lub OXYGOLD
Arc musi zostac spolaryzowany. Szczegoly podano w rozdziale: ,,Przygotowanie do pomiarow”
Instrukcji obstugi czujnikow OXYFERM FDA Arc i OXYGOLD Arec.

Stan polaryzacji sprawdza si¢ nastgpujaco:

1. Wej$¢ w menu do [Sensor] = Tools = Sensor status = Warnings:
measurement.

2. Widoczny na ekranie tekst Polarization timer active wskazuje, Ze ostrzeganie o polaryzacji
jest aktywne.

Zadanie 9: Aktywacja podstawowego interfejsu uzytkownika (Basic User Interface)

Podstawowy interfejs uzytkownika zapewnia uproszczony tryb zarzadzania czujnikiem
z poziomu obstugi Uzytkownika lub Administratora.

W menu [Sensor] = Tools = Measurement nie sa wtedy wy$wietlane nastgpujace
informacje:

o Jednostki gtdéwnych wielko$ci mierzonych,
o Wszystkie parametry pomiaru,
o Nastawienia CIP / SIP,

o Korekta CIP.

[Sensor] = Tools = Calibration: bez zmian.

[Sensor] = Tools = Sensor status: bez zmian.

[Sensor] = Tools = Interface: catkowicie wylaczone.
[Sensor] = Tools = Data management: calkowicie wylaczone.

[Sensor] = Tools = Sensor info: calkowicie wylaczone.
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Aby aktywowac¢ lub wylaczy¢ podstawowy interfejs uzytkownika, nalezy:

1. Wejs¢domenuArc View Handheld 2> Tools 2> Settings > User interface
settings.

2. Wybrac Basic Mode, aby aktywowac podstawowy interfejs uzytkownika, albo Advanced Mode
w celu jego wylaczenia (przejscia do trybu pelnego menu).

Przedstawione wyzej ograniczenia w trybie podstawowego interfejsu uzytkownika, dotycza
tez - analogicznie - menu [Sensor] = View.
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3. Wykrywanie i usuwanie usterek

Ten rozdziat zawiera spis wszystkich komunikatow ostrzezen i bledow oraz opisy procedur
wykrywania i usuwania usterek.

3.1 Wykrywanie i usuwanie usterek - polaczenia bezprzewodowe Wi

Stan wskaznika

Komentarz

Brak potaczenia - bezprzewodowego
lub przewodowego - migdzy recznym
monitorem i wybranym czujnikiem

Polaczenie (bezprzewodowe lub przewo-
dowe) recznego monitora z czujnikiem
jest chwilowo lub trwale utracone.
Mozliwe przyczyny to:

o Czujnik jest poza zasiggiem.

o Wystgpuje zaktocenie cyfrowe.

o Czujnik lub jego interfejs cyfrowy
nie dziata prawidtowo.

Potlaczenie bezprzewodowe migdzy
rgcznym monitorem i wybranym
czujnikiem jest bardzo stabe lub wcale
go nie ma. Polaczenie przewodowe,
jesli istnieje, dziata prawidtowo.

Reczny monitor znajduje si¢ w stacji
dokowania (polaczenie przewodowe)
lub jako$¢ sygnatu bezprzewodowego
dlawybranego czujnika jest zerowa. Nalezy
zmniejszy¢ odleglos¢ od wybranego
czujnika, aby umozliwi¢ komunikacjg.

Jako$¢ sygnatu bezprzewodowego jest
staba.

Odlegtos¢ migdzy recznym monitorem
i wybranym czujnikiem jest na granicy
mozliwosci komunikacji. Nalezy zmniejszy¢
odlegtos¢ od wybranego czujnika, aby
umozliwi¢ komunikacje.

Jako$¢ sygnalu bezprzewodowego jest
akceptowalna.

Odlegto$¢ migdzy recznym monitorem
i wybranym czujnikiem jest ciagle
akceptowalna. Aby poprawi¢ pewnosc
przesylu danych, nalezy zmniejszy¢
odlegtos¢ od wybranego czujnika.

Jako$¢ sygnalu bezprzewodowego jest
bardzo dobra.

Sygnal bezprzewodowy jest bardzo
dobry. Odleglo$¢ od wybranego czujnika
jest wystarczajaco dobra, by zapewnic¢
niezawodne przesylanie danych.

Tabela 3.1:

Wykrywanie i usuwanie usterek polaczen bezprzewodowych
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3.2 Wykrywanie i usuwanie usterek - kolor wskaznika stanu czujnika
na recznym monitorze

Stan wskaznika

Komentarz

&)

Wskaznik stanu dla czujnika na recznym
monitorze jest zielony

Laczno$¢ z czujnikiem jest OK. Czujnik
pracuje poprawnie, wigc nie ma ostrzezen
lub sygnalizacji bledow. (Pulsowanie
wskaznika na zielono oznacza, ze
wlasnie aktualizowane sa dane rgcznego
monitora, przesytane z normalnie dziala-
jacego czujnika. Czyli jest to zjawisko
normalne.)

Wskaznik stanu dla czujnika na rgcznym
monitorze jest zotty

Potaczenie z czujnikiem jest OK. Jednak
czujnik sygnalizuje btad lub ostrzezenie.
Aby przeanalizowac problem, nalezy
wejé¢ do [Sensor] > View >
Sensor status. Na tym ekranie
pokazana jest przyczyna zoltego koloru
wskaznika stanu.

Taki przypadek nie jest komunikowany
przez adapter czujnika Arc Wi.
(Pulsowanie z6ttego wskaznika oznacza,
ze wiasnie aktualizowane sa dane r¢cznego
monitora, przesytane z czujnika sygna-
lizujacego stan ostrzezenia lub bigdu.)

Wskaznik stanu dla czujnika na recznym
monitorze jest czerwony

Reczny monitor Arc View utracit pota-
czenie z czujnikiem na skutek jedne;j,
lub wigcej, z ponizszych przyczyn:

o Jako$¢ sygnatu bezprzewodowego
jest staba.

o Adapter czujnika Arc Wi zostat
odtaczony od czujnika.

o Czujnik jest uszkodzony.

W pierwszym przypadku, nalezy zmniej-
szy¢ odlegtos¢ od wybranego czujnika.
Pozostate przypadki sa dodatkowo sygna-
lizowane przez czerwone $wiatlo na
adapterze Arc Wi danego czujnika.

Tabela 3.2: Wykrywanie i usuwanie usterek - kolor wskaznika stanu czujnika na r¢cznym monitorze
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3.3 Wykrywanie i usuwanie usterek - kolory stanu na adapterze Arc Wi

czujnika

Stan wskaznika

Komentarz

Adapter Arc Wi czujnika
Swieci na czerwono

Jezeli adapter Arc Wi czujnika zostat wlasnie podiaczony do zasilania,
to $wieci on na czerwono w czasie inicjalizacji. Po poprawnej
inicjalizacji adaptera Arc Wi przytaczonego do czujnika, jego
czerwone §wiatlo gasnie.

Jezeli czerwone $wiatlo nie zgasnie, oznacza to brak potaczenia
adaptera z czujnikiem, albo uszkodzenie czujnika. Nalezy odczekac
przynajmniej pi¢¢ minut, aby stwierdzi¢, ze faktycznie istnieje
problem. Adapter Arc Wi czujnika potrzebuje czasu na skanowanie
wszystkich mozliwych adresow urzadzen Modbus przy wszystkich
mozliwych szybko$ciach transmisji. Jezeli problem utrzymuje sig,
nalezy sprawdzi¢ mozliwos¢ braku potaczenia lub uszkodzenia
czujnika.

Adapter Arc Wi czujnika
nie $wieci

Nie oznacza to koniecznie wystapienia problemu.

Albo adapter Arc Wi czujnika i czujnik Arc nie sa podtaczone do
zrodta zasilania, albo dzialaja normalnie.

Adapter Arc Wi czujnika
Swieci na zielono

Nie oznacza to zadnego problemu.

Oznacza, ze czujnik jest aktywnie wybrany na r¢gcznym monitorze
Arc View do obserwacji.

Tabela 3.3: Wykrywanie i usuwanie usterek z pomoca koloréw stanu na adapterze Arc Wi czujnika

3.4 Wykrywanie i usuwanie usterek - komunikaty ostrzezen i stanu

Ostrzezenie oznacza komunikat powiadomienia, ktory pozwala na dalsze dziatanie Systemu
Arc. Tego typu komunikat alarmuje obstugujacych o potencjalnej mozliwosci wystapienia
problemu z czujnikiem Arc, ktéry moze prowadzi¢ do nieprawidlowych wynikéw lub biedow.
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3.4.1 Ostrzezenia dotyczace pomiaru

Ostrzezenia dotyczace pomiaru sa zwiazane z czujnikiem.

Ostrzezenie

Znaczenie

[Reading below lower limit]
Odczyt ponizej dolnej granicy

[Reading above upper limit]
Odczyt powyzej gbrnej granicy

Aktualnie mierzona warto$¢ znajduje si¢ poza zakresem
pomiarowym czujnika.

Czujnik jest uzywany poza jego specyfikacja.

[Reading unstable]
Odczyt niestabilny
(odchylka standardowa >1%)

Czujnik wykrywa niestabilno$¢ mierzonej wielkosci. Moze
to mie¢ miejsce, gdy wlasciwy element czujnikowy
osiaga granice swojej zywotnosci lub, jezeli aktualne
warunki pomiaru sa niestabilne.

[T reading below lower limit]
Odczyt T ponizej dolnej granicy
(T < Tmin, rozdzial&.8. 1) >

[T reading above upper limit]
Odczyt T powyzej gornej granicy
(T > Tmax, rozdziat@.8.1D

Aktualna temperatura znajduje si¢ poza zakresem
pomiaru temperatury czujnika.

[T reading unstable]
Odczyt T niestabilny
(odchytka standardowa >1%)

Czujnik wykrywa niestabilno$§¢ wyniku pomiaru
temperatury. Moze to mie¢ miejsce, jezeli warunki
pomiaru sg niestabilne.

[Polarization timer active]
Timer polaryzacji - aktywny
(tylko OXYFERM FDA Arc
1 OXYGOLD Arc)

Czujnik jest polaryzowany. Ostrzezenie utrzymuje si¢
do zakonczenia czasu polaryzacji.

[USP warning], [USP alarm]
Ostrzezenie USP, sygnalizacja USP
(tylko CONDUCELL PWSE Arc)

Po aktywowaniu, ostrzezenie lub sygnalizacja zgodnie
7 USP <645>.

Tabela 3.4: Ostrzezenia dotyczgce pomiaru dla czujnikow Arc
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3.4.2 Ostrzezenia dotyczace kalibrowania

Ostrzezenia dotyczace kalibrowania sa zwiazane z czujnikiem.

Ostrzezenie

Znaczenie

[Calibration recommended]
Zalecane kalibrowanie

Wykona¢ kalibrowanie, aby zapewni¢ rzetelny pomiar.

[Last calibration not succesful]
Ostatnie kalibrowanie zakonczone
niepowodzeniem

Ostatnie kalibrowanie, przynajmniej w jednym punkcie,
zakonczone niepowodzeniem. Czujnik uzywa parametrow
z poprzedniej, udanej kalibracji. Aby zapewnic rzetelne
pomiary, nalezy wykona¢ kalibrowanie.

[Repleace sensor cap]
Wymieni¢ nasadke czujnika
(tylko DO)

Nasadka czujnika VISIFERM DO Arc musi by¢
wymieniona i trzeba ponownie kalibrowa¢ czujnik
z nowa nasadka.

3.4.3 Komunikaty stanu kalibrowania

Komunikat

Znaczenie

[Calibration Point 1 (2): Below
calibration range]

Punkt kalibracji 1 (2): ponizej
zakresu kalibrowania

[Calibration Point 1 (2): Above
calibration range]

Punkt kalibracji 1 (2): powyzej
zakresu kalibrowania

Wartos¢ mierzona znajduje si¢ ponizej / powyzej
dolnej / gornej granicy dopuszczalnego zakresu
kalibrowania czujnika.

Nalezy zapewni¢ stabilne warunki pomiaru i wlasciwe
wzorce do kalibracji.

[Calibration Point 1 (2):
Temperature too low]
Punkt kalibracji 1 (2):
temperatura za niska

[Calibration Point 1 (2):
Temperature too high]
Punkt kalibracji 1 (2):
temperatura za wysoka

Zmierzona temperatura stosowanego wzorca kalibracji
nie miesci si¢ w dopuszczalnym dla kalibrowania
zakresie.

Aby wykonac¢ pomyslnie kalibrowanie, nalezy zapewnic¢
stabilne warunki pomiaru, mieszczace si¢ w zakresie
ustalonym dla kalibrowania danego czujnika.

Tabela 3.6: Komunikaty stanu kalibrowania dla czujnikow Arc
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Komunikat Znaczenie
[Calibration Point 1 (2): Mierzona temperatura nie jest wystarczajaco stabilna
Drift temperature] do prowadzenia kalibracji.
Punkt kalibracji 1 (2):
dryft temperatury Nalezy zapewni¢ stabilne warunki pomiaru. Czujnik

musi znajdowac si¢ pod dzialaniem odpowiedniego
wzorca kalibracji przez odpowiedni czas, do osiagnigcia
rownowagi.

[Calibration Point 1 (2):
Reading too low]
Punkt kalibracji 1 (2):

Aktualny odczyt czujnika jest zbyt maty/ za duzy dla
uzytego wzorca kalibracji.

odczyt zbyt maty

[Calibration Point 1 (2): Czujnik moze by¢ uszkodzony lub osiaga¢ granice
Reading too high] zywotnosci, albo uzyty wzorzec kalibracji nie jest
Punkt kalibracji 1 (2): wiasciwy dla wybranego punktu kalibracji.

odczyt za duzy

[Calibration Point 1 (2): Aktualny odczyt czujnika nie jest wystarczajaco
Drift reading] stabilny do prawidtowej kalibracji.

Punkt kalibracji 1 (2):

dryft odezytu Nalezy zapewni¢ stabilne warunki pomiaru. Czujnik

musi znajdowac si¢ pod dzialaniem odpowiedniego
wzorca kalibracji przez odpowiedni czas, do osiagnigcia
rownowagi.

[Calibration Point 1 (2):

Punkt kalibracji 1 (2):

incorrect measurement unit]

niewlasciwa jednostka pomiaru

Wybrana jednostka pomiaru nie umozliwia kalibrowania
czujnika.

Nalezy wybra¢ wlasciwa jednostkg pomiaru w menu
Tools & Measurement.

Tabela 3.6: Komunikaty stanu kalibrowania dla czujnikow Arc (ciag dalszy)

3.4.4 Ostrzezenia dotyczace interfejsu

Uwaga
A Ostrzezenia dotyczace interfejsu odnosza si¢ tylko do czujnikow DO Arc.
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Ostrzezenie Znaczenie
[Value below 4 mA] Wynik pomiaru odpowiada wartosci lezacej ponizej
Warto$¢ ponizej 4 mA dolnej granicy wyjscia interfejsu 4+20 mA.

Aby zapewni¢ poprawne wyjscie pradowe dla
opisanych warunkéw pomiaru, nalezy ponownie
skonfigurowac interfejs 4+20 mA czujnika przez menu
Tools =2 Interface configuration > Output
current configuration.

[Value above 20 mA] Wynik pomiaru odpowiada wartosci lezacej powyzej
Warto$¢ powyzej 20 mA gornej granicy wyjscia interfejsu 4+20 mA.

Rozwiazanie jest takie samo jak powyzej.

[Current set point not met] Interfejs 4+20 mA czujnika nie jest w stanie wyregulowac
Nie mozna osiagna¢ pradu pradu do wartosci odpowiadajacej aktualnemu wynikowi
dla warto$ci zmierzonej pomiaru, zgodnie z konfiguracja interfejsu 4+20 mA.

Nalezy sprawdzi¢ przewody petli 4+20 mA oraz napigcie

zasilania.
[Supply voltage too low] Zastosowane napigcie zasilania interfejsu 4+20 mA
Za niskie napigcie zasilania czujnika jest za niskie/ za wysokie.

[Supply voltage too high]

) o e Nalezy zapewni¢ wlasciwe zasilanie, zgodne z danymi
Za wysokie napigcie zasilania

technicznymi czujnika.

Tabela 3.7 Ostrzezenia dotyczace interfejsu dla czujnikow DO Arc

3.4.5 Ostrzezenia dotyczace sprzetu

Uwaga
A Ostrzezenia dotyczace sprz¢tu odnosza sig tylko do czujnikow DO Arc.

Ostrzezenie Znaczenie

[Sensor supply voltage too low]

Za niskie napiecie zasilania czujnika Napigcie zasilania czujnika jest za niskie / za wysokie,

aby mogt on poprawnie pracowac. Nalezy zapewnic
stabilne zasilanie, zgodne z danymi technicznymi
czujnika.

[Sensor supply voltage too high]
Za wysokie napigcie zasilania
czujnika

Tabela 3.8: Ostrzezenia dotyczace sprzetu dla czujnikéw DO Arc
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3.5 Wykrywanie i usuwanie usterek - komunikaty bledow

Komunikat btedu jest komunikatem powiadomienia, ktory alarmuje obstugujacych,
ze wystapil problem, ktory uniemozliwia dalsze dziatanie systemu Arc. Taki problem musi
by¢ usunigty, aby mozliwa byta dalsza praca.

3.5.1 Bledy dotyczace pomiaru
Bledy dotyczace pomiaru sa zalezne od rodzaju czujnika.

Bledy nie zawsze i nie w kazdym przypadku moga by¢ usunigte. Konieczna moze okazac
si¢ wymiana czujnika.

Blad Znaczenie
[Reading failure] Czujnik nie moze dluzej wykonywac¢ pomiarow.
(dla wszystkich czujnikow) Dzieje si¢ tak w przypadku, gdy korpus czujnika
Odczyt niemozliwy lub sam element czujnikowy zostat uszkodzony

(np. calkowita degeneracja nasadki w przypadku
czujnika DO, rezystancja szkta poza dopuszczalnym
zakresem w przypadku czujnikow pH).

[Glass resistance too high]
(tylko dla czujnikow pH)

Rezystancja szkta za duza Rezystancja szkta czujnika pH jest za duza/ za mata

(np. z powodu sthuczenia elektrody szklanej lub wysuszenia
koncowki czujnika)

[Glass resistance too low]
(tylko dla czujnikéw pH)
Rezystancja szkla za mata

[Reference resistance too high]
(tylko dla czujnikow pH)

Rezystancja szkla za duza Elektroda odniesienia czujnika pH wykazuje rezystancje
[Reference resistance too low] poza zakresem podanym w danych technicznych.
(tylko dla czujnikéw pH)

Rezystancja szkla za mata

[Resistance 4 electrodes too high] | Rezystancja dla 4 elektrodowego czujnika przewodnosci
(tylko dla czujnikow przewodnosci) | (Cond.) jest za duza/ za mata (np. z powodu zwarcia
Rezystancja 4 elektrod za duza | lub przerwy obwodu w czujniku, wysuszenia koncowki
[Resistance 4 electrodes too low] | czujnika).

(tylko dla czujnikéw przewodnosci)
Rezystancja 4 elektrod za mata | Nalezy zapewni¢ wlasciwe zamontowanie czujnika.

Tabela 3.9: Bledy dotyczace pomiaru dla czujnikow Arc
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Blad

Znaczenie

[Resistance 2 electrodes too high]
(tylko dla czujnikéw przewodnosci)
Rezystancja 2 elektrod za duza

[Resistance 2 electrodes too low]
(tylko dla czujnikéw przewodnosci)
Rezystancja 2 elektrod za mata

Rezystancja dla 2 elektrodowego czujnika przewodnosci
(Cond.) jest za duza/ za mata (np. z powodu zwarcia
lub przerwy obwodu w czujniku, wysuszenia koncowki
czujnika).

Nalezy zapewni¢ wlasciwe zamontowanie czujnika.

[Reference 2 potential too low]
(tylko dla czujnikow pH)
Potencjat 2 odniesienia za maty

[Reference 2 potential too high]
(tylko dla czujnikow pH)
Potencjat 2 odniesienia za duzy

Roéznica potencjatow migdzy kontrolna elektroda
odniesienia i elektroda odniesienia jest wigksza niz
50 mV. Jest to spowodowane ubytkiem jonow Cl
w elektrolicie odniesienia.

Wkrotce przekroczony zostanie oczekiwany czas
zywotnosci elektrod.

[T sensor defective]
Uszkodzony czujnik temperatury

Ten czujnik nie moze dluzej wykonywaé pomiarow
temperatury. Ma to miegjsce, gdy czujnik temperatury
we wskazanym czujniku ulegt uszkodzeniu.

[Cathode impedance too high]

[Cathode impedance too low]
(tylko dla OXYFERM FDA Arc
1 OXYGOLD Arc)

Nalezy wykonac kroki opisane w rozdziale: ,, Testowanie
i konserwacja” w instrukcji obstugi dla czujnika
OXYFERM FDA Arc lub OXYGOLD Arc.

Tabela 3.9: Bledy dotyczace pomiaru dla czujnikéw Arc (ciag dalszy)
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3.5.2 Bledy dotyczace kalibrowania

Bledy dotyczace kalibrowania sa zwiazane z czujnikiem.

Brak nasadki czujnika

Blad Znaczenie
[Sensor cap missing] Nasadka czujnika DO zostata zdjgta. Nie wolno czujnika
(tylko dla czujnikéw DO) sygnalizujacego taki btad umieszcza¢ w badanym

roztworze. Na czujnik nalezy najpierw natozy¢ nasadke
iwykalibrowaé, aby umozliwiat on wykonanie wiarygodnych
pomiarow.

[Sensor failure]
(tylko dla czujnikéw pH i Cond.)
Uszkodzenie czujnika

Wskaznik jakosci pomiaru dla czujnika jest za niski.
Uzywana kalibracja nie jest wiarygodna.

Mozna préobowac¢ wykona¢ ponowne kalibrowanie
czujnika. Jezeli si¢ ono nie udaje, to znaczy, ze czujnik
osiagnal granicg zywotnosci i trzeba go wymienic.

Tabela 3.10: Bledy dotyczace kalibrowania dla czujnikéw Arc

3.5.3 Bledy dotyczace sprzetu

Bledy sprzetowe moga dotyczy¢ wszystkich czujnikow.

Napigcie zasilania czujnika znacznie
za niskie

Blad Znaczenie
[Sensor supply voltage far too low] | Napigcie zasilania czujnika jest mniejsze niz 6V. Jest
tylko dla czujnikéw DO) to napigcie zbyt niskie, aby czujnik mdgl poprawnie

pracowac.

[Sensor supply voltage far too
high] (tylko dla czujnikow DO)
Napigcie zasilania czujnika znacznie
za wysokie

Napigcie zasilania czujnika jest wigksze niz 40V.
Praca w takich warunkach moze prowadzi¢ do trwalego
uszkodzenia czujnika.

[Temperature reading far below
min.] (tylko dla czujnikow DO)
Odczyt temperatury znacznie ponizej
minimum

[Temperature reading far above max.]
(tylko dla czujnikéw DO)
Odczyt temperatury znacznie
powyzej maksimum

Aktualna temperatura jest co najmniej o 10°C nizsza /
wyzsza od podanej dla czujnikéw VISIFERM DO Arec,
w danych technicznych, minimalnej/ maksymalne;j
temperatury roboczej.

Praca w takich warunkach moze prowadzi¢ do trwalego
uszkodzenia czujnika.

Tabela 3.11: Bledy sprzetowe, dotyczace czujnikow Arc
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Blad Znaczenie

[Internal communication failure] | Wewngtrzna komunikacja czujnika nie dziata.
(tylko dla czujnikéw pH i Cond.) | Byé moze, czujnik pracuje w zbyt wysokiej temperaturze
Uszkodzenie wewngtrznej lub wystapito dla niego uszkodzenie sprzgtowe.

komunikacji
Nalezy zapewni¢ warunki pracy czujnika zgodne

z podanymi w jego instrukcji obstugi.

Tabela 3.11: Bledy sprzetowe, dotyczace czujnikow Arc (ciag dalszy)

3.6 Przywracanie nastawien fabrycznych

Czujniki Arc oraz rgczny monitor Arc View mozna przywroci¢ do pierwotnych, fabrycznych
nastawien domyslnych. Aby wykonac taka procedurg, trzeba mie¢ dostgp (uprawnienia)
poziomu ,,S”, tj. Specjalisty, do danego urzadzenia Arc.

W celu przywrocenia nastawien fabrycznych czujnika, nalezy wejs¢ w menu do [Sensor] -
Tools = Data management = Restore factory settings iklikna¢ OK.

Aby przywroci¢ nastawienia fabryczne monitora recznego Arc View, nalezy wejs¢ w menu
doArc View Handheld > Tools = Settings 2 Restore factory settings
i klikna¢ OK.

Uwaga
Po przywroceniu fabrycznych nastawien domyslnych, wszystkie indywidualne
nastawienia uzytkownika dla danego urzadzenia zostaja utracone.
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